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Introduction 
The MiniPlex-3 series NMEA multiplexers enable connection of multiple NMEA 0183/2000 devices and a 

host device like a PC, a laptop or a tablet. All models share the same number of NMEA ports and feature 

set. They differ in host interface type, the interface that talks to the computer. Some models also have 

an NMEA 2000 interface. 

This manual covers all models of the MiniPlex-3 series. There is a chapter for each type of host port. The 

remaining part of the manual covers NMEA 0183 and NMEA 2000 connections and configuration, which 

are the same for all models. 

NMEA 0183 
The National Marine Electronics Association (www.nmea.org) has defined a communication protocol called 

NMEA 0183, which enables navigation instruments and devices to exchange data with each other. 

Using the NMEA 0183 protocol, an electronic compass can send a heading to a radar to enable a north-up 

display. Similarly, a GPS can send a course to steer, cross-track error and other related information to an 

autopilot to steer a boat to a set waypoint in the GPS. 

NMEA 0183 Sentences 
The NMEA 0183 protocol defines human-readable text sentences with a strictly defined format. These 

sentences can be seen in MPXConfig3, in the top half of the window, and look like the sentences below: 

$GPGGA,143357.999,5301.0061,N,00635.5479,E,1,06,1.9,90.0,M,,,,0000*39 
$GPGLL,5301.0061,N,00635.5479,E,143357.999,A*22 
$HEHDT,67.0,T*1E 

A receiving device or software application will know that a sentence starting with $GPGLL originates from 

a GPS (hence the GP at the beginning of the sentence) and that it contains the geographic longitude and 

latitude (GLL). The $GPGLL part in this example is called the address field of a sentence. 

Talkers and Listeners 
The NMEA 0183 standard defines talkers and listeners. A device that sends information is a talker and a 

device that receives information is a listener. When connected to each other, the talker sends information 

to the listener. 

Communication using the NMEA 0183 protocol involves at least one talker 

sending data to one listener. Figure 1 on the right shows such a minimal 

system: a gyrocompass sends heading data to a radar. 

It is important to know that a talker or listener port is named after its 

function, not after what it is connected to. So, a talker port transmits 

information, and it is connected to a listener port which receives information. This might be confusing at 

times so further in this manual we will use the terms input and output instead of listener and talker port 

respectively. 

The NMEA 0183 standard specifies that an output should have enough driving capacity to talk to four 

listeners. This is as easy to achieve as telling a story to an audience of four people; the only requirement 

is to talk loud enough. 

Gyro Radar

Figure 1 

http://www.nmea.org/
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Figure 2 

The left part of Figure 2 shows an example: one GPS sends data to four devices. 

It gets complicated when one device, for example an MFD (Multi-Function Display), needs to receive data 

from several other devices, as shown in the right part of Figure 2. Unless that MFD has multiple inputs, 

this is not possible without a multiplexer or combiner. 

Simply connecting multiple outputs to one input is like four people telling you a different story 

simultaneously. You can make neither head nor tail of it. In electronics terms: the outputs will short-

circuit each other and the NMEA 0183 sentences they transmit will be corrupted. 

This is where a multiplexer offers the solution. 

The Multiplexer 
A multiplexer (also called combiner) has multiple inputs and can 
therefore receive NMEA 0183 sentences from several devices 

simultaneously. These sentences are placed in a queue and 

transmitted sequentially though one output. 

Since the NMEA 0183 standard clearly defines the beginning and 
the end of a sentence, the receiving device will exactly know how 

to separate the individual sentences from the received stream. 

So, what seems impossible in Figure 2 is possible when a 

multiplexer is added as shown in Figure 3: the multiplexer listens 
to the instruments by receiving NMEA 0183 sentences 

simultaneously and transmits them sequentially to the MFD. 

Extra Ports 
The functionality of a basic NMEA 0183 multiplexer can be 

enhanced by adding extra ports. An extra talker port or NMEA 

0183 output can be used to send information to a repeater display 

at the helm while an extra connection for a computer enables the use of navigation software. If this 

connection is bi-directional instead of just an output, the navigation software can control an autopilot 

The Host Interface 
NMEA 0183 devices already existed before it was common practice to use a computer for navigation. Of 

course, there were ECDIS systems (Electronic Charting and DISplay), but these were used exclusively on 

commercial ships due to their cost and size. 

Nowadays it is very common to use a computer, laptop or tablet as a charting device. The navigation 

software shows exactly where you are and can control an autopilot to automatically follow a programmed 
route. Therefore, this computer, laptop or tablet requires a means to connect to the multiplexer to 

receive GPS position and other information and to send navigation data to an autopilot. This connection is 

called a host interface and can be a USB, Ethernet or WiFi interface. The host interface is also used to 

configure the MiniPlex-3 and to perform firmware updates. 

Throughout this manual, the term host will be used for a PC, laptop, smartphone, tablet or other device 

that is connected to the multiplexers’ host interface to send and receive NMEA data. 
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The MiniPlex-3 Multiplexer 
The MiniPlex-3 multiplexer is an advanced NMEA 0183 multiplexer with four NMEA 0183 inputs or listener 

ports, two NMEA 0183 outputs or talker ports and one or two host interfaces. 

The MiniPlex-3 combines NMEA 0183 sentences received on 

its inputs and can route these sentences to its outputs and 

host interface(s). The host interface(s) can also be used to 

send NMEA 0183 sentences back to the MiniPlex-3 to be 
routed to its outputs and to send configuration sentences to 

the MiniPlex-3 itself. 

Each NMEA output can drive up to four inputs. Flexible 

routing options allow you to specify which NMEA sentences 

are sent to these outputs. 

Figure 4 shows a typical setup where the MiniPlex-3 is used 

to combine data from four instruments, send it to a PC and 

depending on the configuration of the MiniPlex, send the 

same data to an autopilot and a repeater display. 

The navigation software on the PC can control the autopilot 

to steer a programmed route and display information such as distance to next waypoint on the repeater 

display. 

Galvanic Isolation 
The NMEA 0183 standard requires galvanic isolation on each 

input of a device. This isolation provides a barrier against 
stray currents, which could result in data corruption, radio-interference or even worse, melting cabling if 

the stray currents exceed the current rating of a cable. 

As a safety measure, every NMEA input, output and host port of the MiniPlex-3 has galvanic isolation to 

provide maximum protection of connected devices. 

An added benefit of isolated outputs is that they can be connected not only to an NMEA 0183 input 

(RS422) but also to an RS232 input without requiring a level converter. 

NMEA 2000 
MiniPlex-3 multiplexers with an NMEA 2000 port (“-N2K” models) can be connected to an NMEA 2000 

network and thus provide a bi-directional gateway between NMEA 2000 and NMEA 0183 

The NMEA 2000 standard was developed to overcome limitations of NMEA 0183. Whereas NMEA 0183 

only allows point-to-point connections as explained earlier, NMEA 2000 is a network standard in its true 

sense and is based on the CAN Bus, a communication bus used in cars, trucks and other vehicles. 

NMEA 2000 allows multiple devices to connect to one single network and each device can transmit data 

onto that network and receive data from other devices. The communication speed on an NMEA 2000 

network is much higher than on NMEA 0183: 250,000 bits per second vs. 4800 bits per second. 

The information density on NMEA 2000 is also at least twice as high compared to NMEA 0183 because 

data is transmitted in binary* format as opposed to ASCII. 

A complete message - for instance a heading message including deviation and variation, all with a 

maximum precision of 0.006º and a checksum - will require 16 bytes on NMEA 2000. A heading sentence 

on NMEA 0183 containing the same parameters with the same precision, requires 37 bytes. Even with a 

reduced precision of 0.1º, this sentence would still require 31 bytes. 

So NMEA 2000 is not only 50 times faster in communication speed, but also at least twice as efficient.  

Whereas NMEA 0183 data is identified by an address field, (the first 6 characters of a sentence), NMEA 

2000 data is identified by a PGN, a Parameter Group Number. This is a unique number identifying a 
specific group of parameters. PGN 129029 for instance holds the position data, and other parameters 

related to the GPS position fix, like a $GPGLL sentence with NMEA 0183 does. While technically speaking 

the PGN only defines the number, the word PGN is commonly used to indicate the entire message. 

 

* one byte of this binary format can represent a number ranging from 0 to 255 or -128 to +127. In ASCII format, the 
same numerical value would require 3 or 4 characters where each character occupies one byte. 

Figure 4 
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NMEA 2000 Network Topology 
An NMEA 2000 network has a strict topology: it consists of a backbone cable with terminators at each 

end and a power-T to provide power to the network. Each device is connected to this backbone using a T, 

a three-way connector block which is inserted into the backbone and a drop-cable or spur-cable. 

The backbone is galvanically isolated from the rest of the electronics on your boat. A power-hungry 

device such as a plotter or an autopilot with its own power supply connections has a galvanically isolated 

NMEA 2000 interface. A smaller display or sensor may be powered from the backbone though if no other 

electrical connections exist on that display or sensor. 

Each end of the backbone has a terminator, which is a resistor between both data wires CAN_H and 

CAN_L, absorbing electrical reflections on the network. Without these terminators, digital signals will 

reflect against the open ends of the network back into the network, causing distortion of the digital 

signals. 

 

 

Figure 5: Minimalist NMEA 2000 Network 

 

Figure 5 shows a minimal NMEA 2000 network with a plotter and a MiniPlex connected to an NMEA 2000 

backbone. The network consists of a power-T (PT), two Ts to connect the drop cables to the devices and 

two terminators (R) at each end of the backbone. 

Simply connecting the MiniPlex directly to the plotter using a female-female NMEA 2000 cable will not 
work. The NMEA 2000 interfaces of both devices require power from the backbone and termination to 

prevent data corruption. 
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The MiniPlex-3-N2K Multiplexer 
While NMEA 2000 no longer requires multiplexers to connect devices to each other, a MiniPlex-3-N2K 

multiplexer still serves a purpose as a gateway between NMEA 0183 and NMEA 2000. 

Besides being an NMEA 0183 multiplexer providing 

routing between all NMEA 0183 inputs, outputs and 

the host interface(s), the MiniPlex-3-N2K also serves 

as a multiple bi-directional gateway between each 
NMEA 0183 input, output and host interface and the 

NMEA 2000 network. 

Each NMEA 0183 input and the host interface appear 

on the NMEA 2000 network as individual NMEA 2000 
devices, which identify themselves as an NMEA 0183 

Gateway or as the device as selected on the NMEA 

2000 tab in MPXConfig3. 

Each of the inputs and host interface can thus be 
selected as a Data Source on other NMEA 2000 

devices. 

The gateway function enables existing NMEA 0183 

devices to be connected to an NMEA 2000 network 
and share navigation data between “old” and “new” 

devices. 

All NMEA 0183 data received by the MiniPlex-3-N2K 

is converted into NMEA 2000 and transmitted onto 

the NMEA 2000 network. 

Data from the NMEA 2000 network can be selectively converted to NMEA 0183 sentences and routed to 

the NMEA 0183 outputs and host port of the MiniPlex-3-N2K. 

The MiniPlex-3-N2K provides a seamless integration of NMEA 0183 and NMEA 2000 navigation devices. It 
also allows navigation software, which usually only supports NMEA 0183, to receive data from NMEA 

2000 devices and to control NMEA 2000 autopilots. 

Figure 6 shows a typical setup: NMEA 2000 data from the GPS/plotter is converted to NMEA 0183 and 

routed to the PC and a repeater. NMEA 0183 data from the Depth, Wind and Log instruments and the PC 
is converted and transmitted onto the NMEA 2000 backbone and each source of this data can be selected 

as a Data Source by the GPS/plotter and the autopilot. 
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Host Interfaces 
The following section describe the different types of host interfaces of the MiniPlex-3: USB, Ethernet and 

WiFi. Each of them requires different steps and knowledge to connect to it successfully. It is very 

important to read the corresponding paragraphs about the host interface of your MiniPlex-3 carefully to 

avoid problems. Note that all host interfaces are bi-directional: they provide NMEA 0183 data to 
connected devices and these devices can also send NMEA 0183 data to the MiniPlex-3 to control an 

autopilot for instance. 

USB Port 
The USB port requires the installation of a driver. This driver consists of two parts and each of them must 

be installed manually through the device manager (Windows) or by executing an installer (macOS). No 

driver needs to be installed on Linux because all recent Linux distributions contain the ftdi_sio driver 

which matches the FTDI USB chip in the MiniPlex-3. 

The USB port is galvanically isolated from the MiniPlex-3 to prevent ground loops when connected to a 

computer. Ground loops can result in excessive currents in ground connections, which could destroy the 

MiniPlex-3 or the USB port of the connected computer. 

Because of this galvanic isolation, a MiniPlex-3 will not be powered from the USB bus. 

The MiniPlex-3 always requires a power supply on the PWR terminals to operate. 

The USB port circuitry however does receive its power from the USB bus. A computer will therefore 

always show a virtual COM port when the MiniPlex-3 is connected, even without power supply. 

Flow Control 
The USB port supports hardware (CTS/RTS) flow control. This allows the MiniPlex-3 to suspend the flow 

of data from the computer when the host buffer in the MiniPlex-3 is almost full, while data is being routed 
to an NMEA 0183 output. This is necessary because NMEA data is transmitted from an NMEA output at a 

much slower speed than it is received through the USB port. 

When a navigation application only sends a few sentences per second, there is no problem. The host 

buffer can store 512 characters or 6 NMEA sentences of maximum length (82 characters). This is appr. 1 

second of NMEA data at 4800 Baud. 

If an application sends more sentences per second and the host buffer is filled, the excess sentences are 

simply discarded. To prevent this from happening, the navigation application must support hardware flow 

control (CTS/RTS), which usually must be enabled by the user. 

Flow control settings can usually be found in the communication port settings of your software and is 

often called “flow control” or “handshake”. Set the flow control to Hardware or CTS/RTS. Do not use 

Xon/Xoff flow control. The latter uses special control-characters instead of a hardware signal. These 

control-characters are not part of the NMEA standard and therefore not supported by the MiniPlex-3. 

If a navigation application does not support flow control, limit the number of sentences being sent to the 

MiniPlex-3 to a maximum of 480 characters per second. 

There is no need for flow control if no data is being routed from a host interface to an NMEA 0183 output. 
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Driver Installation 
To use a MiniPlex-3 with a USB port, a driver must be 

installed. This driver creates a virtual COM port, which 

can be opened by navigation software. 

Drivers for Microsoft Windows (7, 8, 10 and 11) and 

Apple’s macOS can be found on the download page of 

our website. 

Windows 7 and up 
When the MiniPlex is connected to the computer for 

the first time, Windows will automatically download 

the most recent drivers from the Windows Update 
Service if an Internet connection is available. Without 

Internet connection, these drivers must be installed 

manually. 

To install the drivers for the MiniPlex manually, open 

the Device Manager. 

The Device Manager will show a “ShipModul MiniPlex-

3USB” listed under “Other Devices” as shown in Figure 

7. 

 

 

 

 
 

 

 

 
 

 

 

Right-click on the MiniPlex entry and choose “Update Driver” from the menu that appears. This will open 

the window as shown in Figure 8. 

Choose “Browse my computer for driver 

software”. 

 

 

 

 

 

 

 

 

 

 

 

 

  

Figure 8 

Figure 7 
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A new window opens (Figure 9) where 
you must choose the location of the 

driver. The driver is in the subfolder 

“\USB Driver\Windows” on the MiniPlex 

Driver & Utility CD. 

If you click on “Next”, Windows will 

install the driver. 

 

 

 

 

 

 

 

 

 

When Windows has successfully installed 
the driver, the window as shown in 

Figure 10 appears. 

You can close this window. 

  

Figure 9 

Figure 10 
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The Device Manager will now list a “USB Serial Port” 
under “Other Devices” (Figure 11). For this port to work, 

a second driver needs to be installed. 

Right-click on the USB Serial Port entry and choose 

“Update Driver” from the menu that appears. This will 

open the window as shown in Figure 12. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Choose “Browse my computer for driver 

software”. 

 

 

 

 

 

 

 

 

 

 

 

 

  

Figure 12 

Figure 11 
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A new window opens (Figure 13) where 
you must choose the location of the 

driver again. This time, the location is 

already set, and you can click on “Next”. 

 

 

 

 

 

 

 

 

 

 

 

When Windows has successfully installed 

the second driver, the window as shown 

in Figure 14 appears. 

You can close this window. 

 

 

 

 

 

 

 

 

 

 

 

The Device Manager will now list a “ShipModul MiniPlex 

NMEA Multiplexer” under “Universal Serial Bus 

controllers” and a “MiniPlex-3 Serial Port (COMx)” under 

“Ports (COM & LPT)”. 

  

Figure 13 

Figure 14 

Figure 15 
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Windows XP 
When the MiniPlex-3 is connected to a USB port for the first time, Windows will detect new hardware and 

prompts you for a driver. When asked to automatically search for drivers, answer no and choose the 

option to tell Windows where to find the driver.  Point windows to the folder in which you unpacked the 

driver file from our website. 

The installation on Windows is a two-step process. First, the driver for the MiniPlex-3 will be installed. 

Next, Windows will detect a USB Serial device and will install a second driver. On Windows XP systems, 

there can be a delay of up to 10 seconds between the installation of both drivers, which sometimes leads 
to the wrong conclusion that the installation is complete after the first driver is installed. On Windows 

Vista and Windows 2000 systems, there is only very little delay. 

When the installation is complete, a new virtual COM port will be created. 

If necessary, the number of this COM port can be changed in the Windows Device Manager. Click on the 
“+” sign next to the entry marked as “Ports (COM & LPT)”. This will expand the entry to list all available 

COM ports on your computer. The port for the MiniPlex-3 is listed as “MiniPlex-3 Serial Port (COMx)” 

where “COMx” is the name of the newly created serial port. 

To change this port number, double click on the “MiniPlex-3 Serial Port (COMx)” entry to open the 
property page for this port. Next, select the Port Settings tab and click on the Advanced… button. In 

the appearing window the assigned port number can be changed. Do not change any other setting in this 

window. 

It is possible to select a port number that is already present on the computer, like COM1. The original 
COM1 port will then be disabled if the MiniPlex-3 is connected to the computer. This feature allows the 

port number to be set in a low range from COM1 to COM4, to accommodate software that only allows 

COM1 to COM4 to be selected. 

More than one MiniPlex-3 can be connected at the same time. Every new unit will create a new virtual 
COM port. Once created, the COM port will always be assigned to the same MiniPlex-3 regardless of the 

USB port being used. 

Windows allows a maximum of 256 COM ports. However not all software may be able to select COM ports 

numbered above COM9. 

When installing updated drivers, uninstall the original drivers first with the Add/Remove Programs icon 

in the Control Panel or use the Update Driver button on the Driver tab of the “MiniPlex Serial Port” 

property-page. 

macOS 
The macOS driver is available as a disk image file (.dmg). Double-click on this file to open it. Run the 

installer by double clicking on the icon and follow the instructions on the screen. When the installation is 

complete, plug in the USB cable of the MiniPlex. The MiniPlex will show up in the ports list of your 

navigation software as MiniPlex-xxxxxxxx where the xx-es represent the serial number of the MiniPlex. 
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The latest versions of OS X or macOS do not allow software to be executed if it isn’t downloaded from the 
App Store by default. To allow our drivers to be loaded, open System Preferences and click on 

Security & Privacy. On the General tab in this window, enable Mac App Store and identified 

developers (Figure 16).

 

Figure 16 

Linux 
No driver needs to be installed in Linux as all recent distributions already contain the ftdi_sio driver 

required for the FTDI chip used in the MiniPlex-3. Our VID:PID (0x0403:0xFD4B) is also present in the 

USB configuration tables in Linux. 

The communication speed in your navigation software must be set to 460800 Baud.  
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Ethernet Interface 
The MiniPlex-3E(-N2K) has an Ethernet interface to connect it to a network or router. Through this 

interface, other devices on the network can receive NMEA 0183 data from the MiniPlex-3E and they can 

send NMEA 0183 data to the MiniPlex-3E. 

An application connects to the MiniPlex-3E using its IP address and port number 10110. The default 

protocol is UDP and can be changed to TCP in the Network Settings. 

Using a MiniPlex-3E for the first time can be challenging, depending on how the MiniPlex-3E is connected 
to your computer or network. It also requires some basic networking knowledge, which can be found in 

chapter Network Basics on page 32. 

Several scenarios are possible, all requiring a different procedure: 

1. Existing network/router with DHDP 

2. Existing network with static IP addresses/no DHCP 

3. Direct connection to a computer 

These scenarios also determine how and which IP address the MiniPlex-3E has. 

1. Existing network/router with DHCP 
This is probably the most common situation. A router on the network provides internet access and has 

its DHCP server enabled. All devices on that network will automatically receive a unique IP address 

and network mask from the router and so will a MiniPlex-3E in its factory settings. This places all 
devices within the same logical network: the masked part of their IP address, the network address, is 

the same for each device(see chapter Network Basics on page 32) and they can all communicate 

with each other. 

Start MPXConfig3, set the Port selector in the MiniPlex Connection box to UDP and use menu option 
Tools > MiniPlex-3E > Search to find the MiniPlex-3E. A 

window will show the MiniPlex-3E and its IP address (Figure 

17). Check if the listed IP address is not an Auto-IP address 

in the 169.254.x.x range. This indicates a failure to obtain 

an IP address from a DHCP server. 

Select the entry and click OK or double-click on the entry in 

the list. On the main window of MPXConfig3, the IP address 

is now visible in the Host field in the MiniPlex Connection 
box. If you click on the Connect button, a connection to the 

MiniPlex-3E is established and you can configure it. 

Searching for the very first time will most likely trigger a 

Windows Security Alert. In this window, you must allow 
MPXConfig3 to communicate on all listed network interfaces. 

Click on Allow Access and start the search again. 

If no Windows Security Alert appears and no MiniPlex-3E is 

listed in the search results, you most likely have other 
firewall software block access for MPXConfig3. Configure that firewall to allow MPXConfig3 to access 

through TCP and UDP ports 10110 and 30718. 

On macOS, signed software such as MPXConfig3 for macOS is automatically allowed to receive 

incoming connections, so no special action is required to allow MPXConfig3 for macOS to work. 

2. Existing network with static IP addresses/no DHCP  
All devices on the network have a manually assigned unique IP address and network mask. Since 

there is no DHCP server on the network, the MiniPlex-3E will not receive an IP address. Instead, it will 

assign itself an Auto-IP address in the 169.254.x.x range. This IP address will be shown in the Search 
results window. Since this IP address is on a different logical network than the computer running 

MPXConfig3, it is not possible to establish a connection to the MiniPlex-3E. Even menu Tools > 

MiniPlex-3E > Network Setup will not work because this also requires the MiniPlex-3E to be on the 

same logical network. 

Figure 17 
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The only way to get the MiniPlex-3E on the same network is to select the listed MiniPlex-3E and click 
on Change IP Address. This opens the Assign IP Address 

window (Figure 18). The MAC Address field already contains 

the MAC address of the MiniPlex-3E. Enter an IP address that is 

unique withing your network and click OK. MPXConfig3 will now 
broadcast this IP address to the MiniPlex-3E, and the Search 

results window will list the MiniPlex-3E with the newly assigned 

IP address. 

Select the entry and click OK or double-click on the entry in the 
list. On the main window of MPXConfig3, the IP address is now 

visible in the Host field in the MiniPlex Connection box. If you 

click on the Connect button, a connection to the MiniPlex-3E is 

established and you can configure it. 

Note that no network mask needs to be specified. A correct network mask is required but the Ethernet 

interface of the MiniPlex-3E will assign itself a correct network mask based on the entered IP address. 

3. Direct connection to a computer 
In this case, the MiniPlex-3E is connected directly to a computer using a single Ethernet cable. Ensure 

that the Link-LED (LNK) on the Ethernet port of the MiniPlex-3E lights up green or amber. 

If this LED is off, there is no physical connection between the transmitters and receivers 

in both Ethernet ports (MiniPlex-3E and computer). Most computers can automatically 
switch their transmitter and receiver pins on the Ethernet connector, but some can’t. In 

that case, an ordinary Ethernet cable cannot be used an a so called cross-cable is 

required. 

When the Link-LED is lit, you need to establish if the IP assignment of your computer is set to Manual 

or Automatic (DHCP). You can check that in the Windows network settings. 

In either case, it is required that both the MiniPlex-3E and the computer use the same mode of 

operation: either they both use Automatic and the communicate using their Auto-IP addresses or they 

must both be set to a unique fixed IP address and network mask, so they are both in the same logical 

network. 

If the IP assignment of your computer is set to Automatic (DHCP), use MPXConfig3 menu option 

Tools > MiniPlex-3E > Search to find the MiniPlex-3E. It will show up in the Search results 

window with an Auto-IP address in the 169.254.x.x range.  

Select the entry and click OK or double-click on the entry in the list. On the main window of 

MPXConfig3, the IP address is now visible in the Host field in the MiniPlex Connection box. You can 

now try to establish a connection to the MiniPlex-3E on the MPXConfig3 main window by clicking on 

the Connect button. 

If your computer is set to Manual, either change it to Automatic (DHCP) or follow the steps in (2) 

to set the MiniPlex-3E to a fixed IP address and network mask. 

Network Setup 
To change any of the network settings, make sure the IP address of the MiniPlex-3E is in the Host field in 

the MiniPlex Connection box on the MPXConfig3 main window and select menu Tools > MiniPlex-3E 

> Network Setup This will open the MiniPlex-3E Network Settings window as shown in Figure 20. 

These are the factory default settings. The 
IP address shown here is 0.0.0.0, which 

indicates the MiniPlex-3E is set to DHCP. 

This address is different from what is 

shown in the Search results window 
because the latter shows the IP address 

received from a DHCP server or the Auto-

IP address. 

If desired, a fixed IP address and a 
matching network mask can be entered 

that matches your network. The Gateway 

IP can be left to 0.0.0.0 if you are not 

going to set the MiniPlex-3E to UDP 

Directed. Figure 20 

Figure 18 

Figure 19 
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Figure 21 shows an example of fixed IP settings. 

The protocol is set to UDP. This is the 

preferred method for NMEA 0183 data. 

UDP Mode Broadcast ensures that all 

devices and computers on the same 
network will be able to receive the NMEA 

0183 data. At the same time, all devices 

on that network will also be able to send 

NMEA 0183 to the MiniPlex-3E. 

When the MiniPlex-3E is connected to a 

WiFi router, all WiFi connected devices will 

also be able to receive NMEA 0183 data. 

This can be an advantage over using a 
MiniPlex-3Wi, which limits the number of 

“connected” devices to four. 

Note that UDP Broadcasts always remain within one network. If NMEA 0183 data needs to be transported 

across network boundaries or over the Internet, either UDP Mode Directed or TCP need to be used. Both 

modes limit the number of hosts that can communicate with the MiniPlex-3E to one! 

UDP Mode: Directed 
If you set the UDP Mode to Directed, you must enter a destination IP address in the Destination field. 
If this IP address is not on the same network as the MiniPlex-3E, you must also enter the address of your 

network gateway in the Gateway IP field if the MiniPlex-3E is not set to DHCP. 

When these settings are activated, you will no longer receive any NMEA 0183 data from the MiniPlex-3E 

as they are now transmitted to the destination IP address only. MPXConfig3 will no longer be able to read 
any NMEA related setting nor can they be changed. The network settings however can always be changed 

regardless of this setting. 

So, when UDP mode Directed is to be used, first configure the NMEA settings of the MiniPlex-3E using 

UDP mode Broadcast. Only when all NMEA related settings are completed and verified, change the UDP 

mode to Directed. 

TCP 
Using the TCP protocol is another way to reach the MiniPlex-3E across network boundaries or over the 

Internet. Since the TCP server in the network interface supports only one connection, the number of 

computers/devices that can access the MiniPlex-3E via TCP is limited to one. 

Port Number 
The default port number for NMEA 0183 data is 10110. This is the standard port number for NMEA 0183 
over UDP and TCP. MPXConfig3 uses this port number by default. Some apps however, work with a 

different and fixed port number. 

Saving the Network Setup 
If you click on the OK button to save the network settings, a progress bar will appear, and the network 
interface will be restarted. This takes approx. 7 seconds. The new IP address and protocol will appear 

automatically in the MiniPlex Connection box on the main window of MPXConfig3 when the process is 

completed. 

It is important to know that the protocol chosen in the MiniPlex Connection box on the main window of 
MPXConfig3 only defines how MPXConfig3 connects to the MiniPlex-3E. It does not change the protocol of 

the MiniPlex-3E itself. So, if you need to change the protocol from UDP to TCP, you first need to change 

the network settings of MiniPlex-3E and then choose TCP in the MiniPlex Connection box. 

Reset to DHCP 
To change the network settings from fixed IP back to DHCP, open the network configuration, set the IP 

Address and Gateway IP fields to 0.0.0.0 and click OK. 

The settings of the MiniPlex-3E cannot be verified after this change, so a warning will appear. You will 

now need the Search function to find the MiniPlex-3E with its DHCP-assigned IP address. 

Figure 21 
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Network Recovery 
If a MiniPlex-3E has a fixed IP address outside the network range or if it doesn’t show up in the search 

results window due to a possible misconfiguration in the network 

settings, menu option Tools > MiniPlex-3E > Assign IP can be 

used to recover from such a situation. 

In the Assign IP Address window (Figure 22), enter the MAC 

address of the MiniPlex-3E which can be found on the label on the 

topside of the device, below the serial number. 

Enter the MAC address with the fields separated by dashes as 

shown. Then enter a valid IP address for your network or 0.0.0.0 to 

reset the MiniPlex-3E to DHCP and click on OK. A progress bar will 

appear during the update process, which will take approximately 10 
seconds. After that, the MiniPlex-3E can be found again using the 

Search option. 

In case of a duplicate IP address on the network, it is necessary to disconnect the “offending” device first, 

before being able to control/reset the MiniPlex-3E. 

  

Figure 22 
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WiFi Interface 
The MiniPlex-3Wi(-N2K) can communicate wirelessly with devices like smartphones, tablets and PCs 

through its WiFi interface. This WiFi interface provides an access point which other devices can join. A 

WiFi client is also provided, allowing the MiniPlex-3Wi to join an existing WiFi access point. 

Connecting to the MiniPlex-3Wi using its WiFi interface requires some basic networking knowledge, which 

can be found in chapter Network Basics on page 32. 

WiFi Access Point 
The MiniPlex-3Wi provides an 802.11b/g/n wireless access point with the following parameters: 

SSID (name): MiniPlex-xxxxxxxx 
Password: MiniPlex 

Security: WPA2 

IP address: 10.0.0.1 

Port: 10110 
Protocol: TCP and UDP 

DHCP: yes 

DHCP Range: 10.0.0.2 – 10.0.0.9 

The xxxxxxxx-es are the serial number of the MiniPlex-3Wi as printed on the serial number sticker. This 

uniquely identifies a MiniPlex-3Wi from other access points. 

A maximum of four devices may join the MiniPlex-3Wi access point at a time. On all devices, apps may 

connect via UDP simultaneously. TCP is however limited to one connection only. TCP and UDP can be 

used simultaneously. 

The NMEA data from the MiniPlex-3Wi is available on the WiFi network via TCP/UDP port 10110. 

To join the MiniPlex-3Wi access point, open the WiFi settings on your device and look for the MiniPlex 

network. 

On an iPad for instance, the MiniPlex-3Wi will appear as shown in Figure 23. 

 

Figure 23 

 

Tap on the MiniPlex entry to connect and enter the password “MiniPlex” when prompted. 

After a successful connection, a warning may appear, telling you there is no internet connection. This is 

correct: the MiniPlex does not provide a connection to the Internet. You can ignore this. 

The built-in DHCP server of the MiniPlex-3Wi automatically assigns IP addresses to devices that join its 

access point. This DHCP server assigns up to four IP addresses to a maximum of four devices. Many iOS 

and Android devices now have a feature called “Private WiFi Address”. This feature needs to be switched 

off for the MiniPlex access point settings because it makes your mobile device request a new IP address 
regularly. This will quickly exhaust the DHCP pool of the WiFi interface of the MiniPlex, which effectively 

disconnects your mobile device from the access point. 

If the “Private WiFi Address” feature cannot be disabled on your mobile device, you can work around this 

by setting a fixed IP address in your device. This address needs to be unique for each device that is 

connected to the MiniPlex and should be within the range of 10.0.0.10 – 10.0.0.254. 

It is also not required nor possible to assign an IP address to the MiniPlex-3Wi when joining its access 

point: it is always fixed to 10.0.0.1. 

Do not attempt to use any of the Tools > MiniPlex-3E sub-menus of MPXConfig3, as they are 

exclusively for the MiniPlex-3E and do not work on a MiniPlex-3Wi. 

  



 

24 

In your navigation application, you need to enter the IP address of the MiniPlex-3Wi, which is 10.0.0.1. 

The port number to use is 10110. Figure 24 shows the settings in iNavX®, for example. 

 

Figure 24 

 

The WiFi interface and the USB port of an MiniPlex-3Wi operate simultaneously and with the same 

priority. This allows an on-board fixed computer to be connected simultaneously with wireless devices. 

No data is routed between the WiFi interface and the USB port! This means that you cannot 

see any data transmitted by a navigation app in MPXConfig3 on the USB port and vice-versa! 

App Behaviour 
When switching between apps, it is not always clear from their documentation if an app closes a TCP 

connection. As mentioned earlier, the MiniPlex-3Wi supports one single TCP connection at a time. 

Switching from one app to another is usually done by pressing/touching the home button on your device 
and selecting the new app. The app that was running before however, is not closed! It is merely switched 

to the background. Depending on what the developer of the app has envisioned, the app can go to sleep, 

or it can keep running. 

In either case, it can also keep the TCP connection open for a background task like logging your position. 
It is then impossible for the new app that is just started to open a TCP connection. iNavX behaves “nice”: 

it closes the TCP connection and only reopens it when you activate the app again. But other apps might 

not close the TCP connection, preventing other apps from opening it. 

If that is the case, the only way of making the app close the TCP connection is to really terminate the 

app. 
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Changing SSID and Password 
The SSID (the network name) and passphrase of the MiniPlex-3Wi network can be changed. Start 

MPXConfig3 and connect though the USB/COM port. Menu Tools > MiniPlex-3Wi > Setup WiFi 

Parameters will open a window showing the current WiFi access point settings: 

 

Figure 25 

 

The settings shown are the factory-default settings. You can enter a new SSID up to 32 characters. The 

password must be 8 to 31 characters. 

Since access points are often set to channel 1 by default, it is wise to choose a different channel. Marina 

access points are notoriously known to use channel 1 and high (illegal) power levels. These access points 

can severely interfere with the MiniPlex-3 to an extent that the access point of the MiniPlex-3 cannot be 

reached. 

It is also possible to change the access point parameters through a web browser. Start your browser and 

go to http://10.0.0.1 In the window that pops up, enter username “admin” and password “MiniPlex”. 

Note that this password remains unchanged when you change the WiFi password. 

When the web interface appears, select Network from the menu on the left. 

 

Figure 26 

 

On the top of the page that appears, select ap0, Link and Configuration. This will show the current 

access point “ap0” configuration (Figure 26). 
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Change the SSID and Passphrase as desired and click on the “Submit” button which appears at the 
bottom of the table. The maximum length of the SSID is 32 characters. The password must be 8 to 31 

characters. 

The WiFi interface will restart with the new credentials, and you will need to re-join the WiFi network with 

these credentials. 

SSID/Passphrase Recovery 
If you lost the passphrase, you can restore the SSID and passphrase to its factory settings with 

MPXConfig3. Start MPXConfig3 and connect though the USB/COM port. Menu Tools > MiniPlex-3Wi > 
Initialize WiFi Interface will reset the WiFi interface to its factory settings. This process takes appr. 40 

seconds. 

Enabling or disabling the WiFi interface 
If desired, the WiFi interface can be disabled with the following command: 

PSMDWI,D 

To enable the WiFi interface again, use the following command: 

PSMDWI,E 

These commands must be entered in MPXConfig3 in the Send NMEA box while being connected through 
USB. When disabled, the WiFi interface will be switched off and none of the menu items or commands 

regarding the MiniPlex-3Wi will work, except the command to enable the WiFi interface. 

Joining an existing WiFi Access Point/Router 
The WiFi interface of the MiniPlex-3Wi can be configured to join an existing WiFi access point/router on 

your boat. This lets you access the NMEA 0183 data provided by the MiniPlex-3Wi from anywhere on your 

main on-board network without needing to switch the WiFi connection of your remote device between 

both WiFi access points. 

The MiniPlex-3Wi provides a web interface to configure the WiFi module. We strongly recommend not to 

change any other setting in the web interface than what is described here, as some settings are critical 

for the NMEA data communication. If you do change things “beyond repair”, use the procedure described 

in SSID/Passphrase Recovery above. 

The following steps outline the procedure to let the MiniPlex-3Wi join an Access Point: 

• Connect your computer or tablet to the MiniPlex WiFi Access Point (AP). 

• Open a web browser and type 10.0.0.1 in the URL address bar. 

• An authentication is required (Figure 27), use username “admin” and password “MiniPlex” 

 

Figure 27 
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• You will see the following web page (Figure 28): 

 
Figure 28 

• Click on QuickConnect to go to the WLAN Link Scan page (Figure 29), which shows all the access 

points found by the MiniPlex-3Wi. 

 
Figure 29 

• Click on the access point Name you want to join. 
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• This will show a WLAN Profile page of the selected access point (Figure 30). 

 
Figure 30 

• Enter the password of your access point and click on Submit. 

• You will see notifications that all changes are made and saved (Figure 31). 

 
Figure 31 
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• Go back to the status page by selecting Status from the menu on the left (Figure 31) 

 
Figure 32 

• Check that the WLAN interface is connected (black outline in Figure 32) 

• You can see the new IP address of the MiniPlex-3Wi in the red outline in Figure 32. This is the 

address you need to enter in your navigation app to connect to the MiniPlex-3Wi. 

At this point, you can only connect to this IP address using TCP. The UDP server is still linked to the 
access point (ap0) interface of the MiniPlex-3Wi and cannot be active on both the access point and 

the client interface (wlan0) at the same time. If you need UDP to work while the MiniPlex-3Wi is 

connected to your access point, another setting needs to be changed. To do this, write down the IP 

address including the number after the slash (“/”). Then Click on Tunnel in the menu to go to the 

Tunnel 1 Status page (Figure 33). 
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Figure 33 

• Click on Connect on the top of the page. 

 

Figure 34 
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• On the page that appears (Figure 34), click on the Edit on the Host 1 line as shown. Now you can 
change IP address into the broadcast address of your existing access point, which is the tricky bit. If 

the IP address you wrote down in step 12 needs to be changed depending on the number after the 

slash character. This number determines how many groups of the IP address must be changed to 

255, according to the table below: 
 

 aaa.bbb.ccc.ddd/24: aaa.bbb.ccc.255 

 aaa.bbb.ccc.ddd/16: aaa.bbb.255.255 

 aaa.bbb.ccc.ddd/8: aaa.255.255.255 
 

So if the IP address in step 12 was 192.168.15.106/24, you need to enter 192.168.15.255 here. 

 

Figure 35 

• Enter the broadcast address in the Address line as shown in Figure 35 and Click on Submit. A 

notification is shown in green text if the setting is stored successfully. 

Your MiniPlex-3Wi is now all set and you can access the MiniPlex-3Wi using both UDP and TCP via your 

own access point. 

You can still join the access point of the MiniPlex-3Wi and use TCP at the same time. 
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Network Basics 
To understand how a networked MiniPlex-3E or MiniPlex-3Wi works and how to connect to it, some basic 

knowledge of IP addresses, port numbers and protocols is required. 

IP Address 
Every device on a network has a unique number to be able to identify that device. This allows us to send 

a message to one single device on a network. These numbers are called MAC addresses. Every device in 

the world that is connected to a network has such a MAC address. The MAC address of a device is 

sometimes printed on a label and looks like this: 

00-20-4A-E4-28-58 

These hexadecimal addresses are a bit cryptic and not easy to work with, and there are not enough MAC 

addresses available for each networking device in the world. Therefore, a mechanism is used to assign an 
easier to read number to a device, called an IP address*. An IP address consists of four numbers grouped 

together, separated by dots. Each number can range from 0 to 255. An IP address looks like this: 

192.168.1.45 

Assigning an IP address to a device could be compared to sticking a coloured label to your house. Now 
the postman only needs to remember the colour of your label instead of your complete address. Of 

course, someone needs to manage a list that matches the colour to your address to prevent two houses 

of receiving the same-coloured label. Networks and network devices have mechanisms built in that take 

care of this, so we don’t have to worry about it (ARP or Address Resolution Protocol). 

Network Mask 
Another tricky bit of networking is a network mask. A network mask basically determines (masks) which 
part of an IP address is the network address and which part is the device address. In its most basic form, 

a network mask consists of four numbers, like an IP address, that are either 255 or 0. And the 255’s 

always come first. A device always has an IP address AND a network mask, for instance: 

192.168.1.45 and 255.255.255.0 

This combination of IP address and network mask tells us that the first three numbers (or more precisely: 

the first 24 bits) of the IP address are the network address (192.168.1.0) and the fourth number (45) is 

the device address. It also means that this combination limits the number of devices on this network to 

254. 0 is the network address and 255 is the broadcast address, used to address all devices on the 

network at once. 

A broadcast address allows us to send a single message to all devices on the network, instead of sending 

it to one single device. This is called a broadcast (see below). In this example, the broadcast address is 

192.168.1.255. The last number here is 255, which means that it targets all devices on the network. 

Having an IP/network mask combination of 192.168.1.45/255.255.0.0 means that the network address is 

192.168.0.0 and the device address 1.45. There are 65534 possible devices (0.0 and 255.255 are 

reserved) and the broadcast address is 192.168.255.255. 

If you’re completely lost at this point, don’t worry. Just remember the two requirements for devices to be 

able to communicate with each other: 

• All devices must have the same netmask 

• All devices must have the same network address 

If two devices are connected to the same physical network and their network masks differ, they won’t be 

able to communicate with each other since they are both on a different logical network. 

Port Number 
A port number can be seen as a sub address within one single device. It allows a single device to offer 

multiple services, identified by a port number. 

A network message always contains the IP address of the sender and the receiver and a port number. 

The port number is just a logical number identifying the type of data or service in the message. 

Different port numbers allow a web server to offer standard http through port number 80, https through 

port number 443 and e-mail services through other port numbers. 

 

* MiniPlex-3 products only support IP V4 addresses. 
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Port numbers are not chosen arbitrarily. A certain range is standardized and controlled by an organization 

called IANA. 

The MiniPlex-3E uses port number 10110, which is a registered port number for NMEA data. This is the 

port number you enter in your navigation software. 

The MiniPlex-3E uses port number 30718 for configuration of the network interface. MPXConfig3 uses this 

port to transfer the contents of Network Settings dialog to the MiniPlex-3E. 

Assigning IP addresses/DHCP 
When devices are connected to a network, they must all have a unique IP address and a matching 

network mask. One way of achieving this is to set the IP address and network mask of each device 

manually. The other way is to let a DHCP server take care of this. 

DHCP is an acronym for Dynamic Host Configuration Protocol, which it is a mechanism to automatically 
assign IP addresses, network masks and other parameters to devices (hosts) on a network. A DHCP 

server on a network will respond to requests from DHCP clients to obtain an IP address. 

In a typical network environment, a router acts as a DHCP server while other devices such as computers, 

tablets and smartphones are DHCP clients receiving IP addresses from the DHCP server. This ensures 
that you can connect these devices to the network without worrying about IP addresses and network 

masks, all of this is taken care of by the DHCP server. 

The MiniPlex-3Wi acts as a WiFi access point with a DHCP server. When a device joins its WiFi network, it 

will automatically receive an IP address and network mask from the MiniPlex-3Wi. The only thing you 
need to do is to enter the fixed IP address of the MiniPlex-3Wi (10.0.0.1) and port number (10110) in 

your navigation software. 

The MiniPlex-3E is completely different in this respect. It has a DHCP client and thus relies on a DHCP 

server already present on the network to obtain an IP address and network mask automatically. If no 
DHCP server is present, you must manually setup an IP address and network mask. This is the case for 

instance, if your “network” is just the MiniPlex-3E and a computer. Obviously, you will need to assign a 

manual IP address and network mask to your computer too in this case. 

Auto-IP 
When DHCP requests remain unanswered, a device assigns itself an IP address in the range of 

169.254.0.0 to 169.254.255.254 with a network mask of 255.255.0.0. This is called an Auto-IP address. 

Although two devices with an Auto-IP address on the same network can perfectly communicate with each 
other, this is not a desired situation because these addresses are assigned randomly Also, the time it 

takes for a device to auto-assign varies wildly from a few seconds to over a minute. 

Protocols 
Two transport protocols are available for sending data over the network: UDP and TCP. UDP can be used 

in two different modes: Broadcast and Directed. 

A metaphor describing the differences between these protocols: 

UDP Broadcast: A speaker (the MiniPlex-3), in front of an audience (all computers on the network). The 

speaker talks, the audience listens. But the speaker does not know who listens and who 

doesn’t. These is no direct “connection” between the speaker and each member of the 
audience. Each person in the audience can shout something at the speaker and the 

entire audience will hear what he says, including the speaker. 

UDP Directed: A speaker addresses one single person in the audience and all others cover their ears. 

The speaker will however hear everyone in the audience. 

TCP: Call someone on the phone. Your navigation software or MPXConfig3 calls the MiniPlex-3 

to send and receive navigation data and configuration commands respectively. But the 

MiniPlex-3 can answer only one phone call at a time. 
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UDP Broadcast 
NMEA sentences are transmitted on the network as UDP messages to the broadcast address. Every 

device on the network will receive these messages. At the same time, any device on the network can 

send data to the MiniPlex-3, either to its IP address (directed) or as a broadcast. UDP Broadcast has the 

following properties: 

• Every device on the network will receive NMEA data from the MiniPlex-3. 

• Every device on the network can send NMEA data to the MiniPlex-3. 

• Other MiniPlex-3Es on the same network will also receive each other’s data. It is therefore possible 
to send NMEA data over the network from one NMEA device to another. Care should be taken to 

prevent buffer overflows by selectively routing the desired NMEA data to an NMEA output at the 

receiving end and blocking unwanted NMEA data. 

• Routers do not pass UDP Broadcasts from one network to another, so this mode can only be used on 

one physical network. 

• Delivery of NMEA data is not guaranteed, messages can be lost. 

• Wi-Fi routers often assign a low priority to UDP broadcasts, resulting in dropped messages. Typically, 

up to 5% of the messages gets lost. 

To be able to receive UDP on a specific port number, 10110 in our case, an application needs to setup a 

UDP connection and bind this connection to the port number. Operating systems generally allow only one 

application to bind to a port number. This implies that while UDP broadcasts reach every single device in 

a network, only one application on each device can receive these broadcasts. It is therefore not possible 

to run navigation software and MPXConfig3 simultaneously on the same computer. 

UDP Directed 
When using directed UDP, data is transmitted on the network as UDP messages to a specific IP address. 
Only one device with a matching IP address will receive these messages. The advantage is that directed 

UDP travels across routers and networks and can therefore also be used to send NMEA data over the 

Internet. Any device on the network can send data to the MiniPlex-3 either to its IP address (directed) or 

as a broadcast. Directed UDP has the following properties: 

• Travels across routers/networks and the Internet. 

• Higher chance of delivery than UDP broadcast. 

• Every computer on the network can send NMEA data to the MiniPlex-3. 

• Only one computer can receive NMEA data from the MiniPlex-3. 

• Delivery of NMEA data is not guaranteed, messages can be lost. 

TCP 
When using TCP, an application opens an exclusive connection with the MiniPlex. The MiniPlex-3 is the 

TCP server, the application is the TCP client. 

The TCP protocol is reliable and guarantees delivery of data. Data is acknowledged by the receiver and 

retransmitted if data is lost on its way to the received. A TCP connection is bi-directional, so the 

application that opens the connection can both receive and transmit data from/to the MiniPlex-3. 

Both the MiniPlex-3E and the MiniPlex-3Wi are limited to one single TCP connection at a time. 

TCP has the following properties: 

• Travels across routers/networks and the Internet. 

• Only one computer or similar device may communicate with the MiniPlex-3. 

• Reliable connection. Lost messages are automatically retransmitted. 

Although TCP might seem the best option from the above, it is favourable to use UDP because NMEA 

0183 and NMEA 2000 are also broadcast protocols without any form of acknowledgement of received 

data. Data is simply transmitted periodically, and a missing message is usually no problem because data 

is repeated. 

Also, the TCP protocol enforces retransmissions on a bad (WiFi!) connection. This can cause delays in 

data delivery and result in “outdated” data. 
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NMEA 0183 Ports 
The NMEA 0183 ports are the inputs/listener ports and outputs/talker ports of the MiniPlex-3, which 

connect to NMEA 0183 ports on navigation instruments, chart plotters etc. There are many 

interpretations and variations of NMEA 0183 ports, so we’ll explain a few things first. 

NMEA 0183 Signals 
Although the NMEA 0183 standard specifies the signal names, voltage levels and connection methods 

very clearly, the reality is far from this ideal world. 

The most important property of an NMEA 0183 port is that the connections or wires are labelled “A” and 

“B” and that it uses differential signalling according to the RS422 standard. This means that data is 

transmitted on both wires, using opposite voltages. Both wires are driven between 5V and 0V and 

opposite of each other: when wire A is at 5V, wire B is at 0V and vice versa. The advantage of this type 

of signalling is its resilience against electrical interference. 

NMEA A and B are often labelled as NMEA + and NMEA – respectively. Other commonly used names for 

outputs are TX+/TX–, Out+/Out– or Out ve+/ve–. Inputs are often labelled as RX+/RX–, In+/In– or In 

ve+/ve–. 

In all these cases, a “+” terminal connects to an A terminal of the MiniPlex-3 and a “–” terminal connects 

to a B terminal of the MiniPlex-3. 

Some devices even have NMEA + and NMEA – labelled the wrong way. It is perfectly safe to swap the 

wires in case no signal is received. 

Things get confusing when manufacturers don’t follow the NMEA 0183 standard, which is very often the 

case. Many devices have an NMEA 0183 interface, which is electrically speaking an RS232 interface. The 

only resemblance with the NMEA 0183 standard is the data format. Electrically, they operate on different 

voltages and the signal names are different. The signal names used differ wildly and often lead to 
confusion. When a device has a NMEA input with connections Data In and Data Return, it is often not 

clear whether this input is galvanically isolated or if Data Return is simply another name for Signal 

ground or even a power ground. 

Instead of being fully compatible with the NMEA 0183 standard, many devices use single-ended inputs 
and outputs, where data is transmitted or received through one single wire while the power ground 

provides the return path. Single-ended devices often use connection names like TX and Gnd (transmit 

and ground) for an NMEA 0183 output while RX and Gnd (receive and ground) are being used for an 

NMEA input. Also used are Data Out, Data In and Signal Ground. Mix these with standard NMEA 

connections and confusion is imminent! 

The MiniPlex-3 eliminates the confusion through its galvanically isolated NMEA inputs and outputs. 

Because of this isolation, a ground reference no longer exists. Both the A and B signals of every NMEA 

0183 port of a MiniPlex-3 are completely “floating” and can be connected to any type of NMEA 0183 input 

or output of a device, whether they are differential or single-ended, RS422 or RS232. 

NMEA 0183 Inputs 
The MiniPlex-3 has four NMEA 0183 inputs, called In1 to In4. Each input should be connected to one 

output only. These inputs are galvanically isolated from the MiniPlex-3, as specified by the NMEA 0183 

standard. Because of this isolation, it is safe to connect an input to any kind of output: NMEA/RS422 or 

RS232. In case of an RS232 output, its Ground connection must be connected to the B terminal of the 

NMEA input. 

The default communication speed of the NMEA 0183 inputs is 4800 Baud. Higher speeds up to 115200 

Baud can be selected. 

The speed setting of NMEA In4 is linked to the speed setting of NMEA Out1! 

When you change the speed of In4, the speed of Out1 will follow. 

NMEA 0183 Outputs 
The MiniPlex-3 has two NMEA 0183 outputs called Out1 and Out2. Each output can drive up to four NMEA 

0183 inputs. These outputs are galvanically isolated from the MiniPlex-3. Because of this isolation, it is 

safe to connect an output to any kind of input: NMEA/RS422 or RS232. In case of an RS232 input, its 

Ground connection must be connected to the B terminal of the NMEA output. 
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The default communication speed of the NMEA 0183 outputs is 4800 Baud. Higher speeds up to 115200 

Baud can be selected. 

The speed setting of NMEA Out1 is linked to the speed setting of NMEA In4. 

When you change the speed of Out1, the speed of In4 will follow. 

The “C” terminal of NMEA Out2 is not used for NMEA 0183 and should always be left unconnected. 

Connecting to other devices 
Figure 36 shows how instruments with different types of NMEA 0183 ports (NMEA/RS422 and RS232) can 
be connected to the NMEA 0183 inputs and outputs of the MiniPlex-3. Note that it is perfectly safe to 

connect an NMEA 0183 output of the MiniPlex-3 to more than one receiving device, even if their inputs 

are of a different type. 

 

Figure 36 

Combining Ports 
It is sometimes necessary to combine an NMEA 0183 input and an output of the MiniPlex-3 to connect to 

another device such as a GPS with an RS232 port. 

An RS232 port is a single-ended port and provides three connections: TxD (data out), RxD (data in) and 

Ground. Figure 37 shows how such a GPS should be connected, preferably to In4 and Out1 because both 
ports always have the same communication speed. The Ground connection may also be the power ground 

of the GPS. 

 

Figure 37 
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SeaTalk 
Port NMEA In1 of the MiniPlex-3 can be switched from NMEA to SeaTalk* mode. Thus, NMEA In1 becomes 

a fully bi-directional SeaTalk port, capable of receiving and transmitting SeaTalk data. This SeaTalk port 

can be connected to an existing SeaTalk network as shown in Figure 38. 

 

 

Figure 38 

The SeaTalk port is galvanically isolated, so the MiniPlex-3 will not receive power from the SeaTalk 

network. If required, the MiniPlex-3 can be powered from the SeaTalk network by adding two wires, 

indicated by the dashed red and grey lines in Figure 38. It is recommended though to power the 

MiniPlex-3 separately. 

The MiniPlex-3 can replace the Raymarine PC/SeaTalk/NMEA Interface Box (E85001). All SeaTalk 

datagrams required for navigation purposes, including controlling an autopilot, are supported. 

On MiniPlex-3 N2K models, data is also converted between SeaTalk and NMEA 2000/SeaTalkNG and the 

MiniPlex-3 can replace the Raymarine SeaTalk-STNG converter (E22158) if In1 is set to SeaTalk-STNG. 

Conversions from SeaTalk to NMEA 
All SeaTalk data is converted automatically to NMEA 0183 and NMEA 2000. The routing table can be used 

to selectively route converted data to the NMEA 0183 outputs and the host port. See the Technical 

Reference starting on page 78 for an overview of supported SeaTalk datagrams. 

Conversions from NMEA 0183/2000 to SeaTalk 
No NMEA 0183 or NMEA 2000 data is converted to SeaTalk by default, because there can be multiple 

NMEA 0183 or NMEA 2000 sources of the same data, whereas on a SeaTalk network only one single 

source of a particular type of data may exist. 

It is therefore always required to use the routing table to define which NMEA data is converted to 

SeaTalk. When In1 is set to SeaTalk mode, the ST column in the Outputs-section of the routing table 

will be enabled and a checkbox in that column enables the conversion of the NMEA sentence of that entry 

to SeaTalk. 

Example 
The example in Figure 39 shows the required routing entry to let a navigation application control an 

autopilot connected through SeaTalk. The GPRMB sentence contains all the parameters the autopilot 

requires. 

 

Figure 39 

  

 

* SeaTalk is not to be confused with SeaTalkNG, which is Raymarine’s own version of NMEA 2000. The original SeaTalk 
is also referred to as SeaTalk1. 
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NMEA 2000 Port 
MiniPlex-3 multiplexers with an NMEA 2000 port (the “-N2K” models) can be connected to an NMEA 2000 

network or backbone. The MiniPlex-3 can also be connected to a SeaTalkNG network using a Raymarine 

SeaTalkNG to DeviceNet cable (no. A06075). SeaTalkNG is compatible with NMEA 2000.  

MiniPlex-3xx-N2K multiplexers are NMEA 2000 Certified devices and fully compliant with NMEA 2000 
V2.000. Some NMEA 2000 V1.3xx features are implemented to improve interoperability with NMEA 2000 

V1.3xx compliant devices. 

NMEA 2000 messages, called PGNs, are converted into NMEA 0183 sentences and vice-versa. No NMEA 

2000 data is transmitted on the Host ports and WiFi interface simply because there is no standard 

defined for this. 

Devices and Virtual Devices 
Every device on an NMEA 2000 network announces itself on start-up and when interrogated by another 

device. This way each device knows about other devices on the network, allowing it to select a specific 

device as data source. 

This requires that every device announces itself by a unique number called a NAME. 

One physical device can announce itself on the NMEA 2000 network multiple times, using a unique NAME 

for every announcement. These devices are called virtual devices. This way a single physical device 

shows up on the network as multiple virtual devices. 

The MiniPlex-3 uses six virtual devices: one Main device, and one device for each NMEA 0183/SeaTalk 
input and the conversion results. Thus, if a MiniPlex-3USB-N2K is connected to a NMEA 2000 network, it 

will appear in the Device List of another device as shown below: 

 

Model ID Serial No. 

MiniPlex-3USB-N2K - Main 39001234 

MiniPlex-3USB-N2K - In1 39001234 

MiniPlex-3USB-N2K - In2 39001234 

MiniPlex-3USB-N2K - In3 39001234 

MiniPlex-3USB-N2K - In4 39001234 

MiniPlex-3USB-N2K - Cnv 39001234 
 

Each of these devices transmits data that is received on the corresponding NMEA 0183 input and can be 

selected as a data source. This allows a specific selection of data if two inputs of the MiniPlex-3 receive 

the same type of data. 

For example, if a GPS is connected to In1 and an AIS transponder to In2, there will be two sources of 
GPS location on the NMEA 2000 network: “MiniPlex-3USB-N2K - In1” and “MiniPlex-3USB-N2K - In2”. On 

a receiving device, one of both inputs can thus be selecting as data source for GPS location. 

The Main device transmits data received on the Host port (USB, Ethernet, WiFi) and is the only device 

transmitting system-related data like System Time (PGN 126992) or the LEN value. 

The virtual device ending on Cnv transmits NMEA 0183 conversion results. 
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Connecting to an NMEA 2000 network 
The MiniPlex-3 is equipped with a standard Micro-C style male connector. Connect the MiniPlex-3 with a 

spur- or drop-cable and a T-piece to the NMEA 2000 backbone. 

NMEA 2000 networks must always consist of a powered backbone with terminators, to which the 

MiniPlex-3 and other devices are connected. It is not possible to simply connect two NMEA 2000 devices 

directly together. An NMEA 2000 backbone needs to be powered and terminated on both ends. 

Even if a MiniPlex-3 N2K is the only NMEA 2000 device to connect NMEA 0183 devices to a new NMEA 

2000 enabled plotter, a minimal NMEA 2000 network needs to be built as shown in Figure 40. 

 

Figure 40 

Besides cables, this setup requires the following components: 

PT: Power Tee, supplies power to the NMEA 2000 network 

T: Tee for a drop cable to a device 

R: Terminator resistor (2x!) 

  



 

40 

Protocol Conversions 
The MiniPlex-3 converts navigation data between all three supported protocols – NMEA 0183, NMEA 2000 

and SeaTalk – and in all directions. 

There are subtle differences however in the way each of these conversions work. Knowing these 

differences can be of great help when adding entries to the routing table. 

The diagram below (Figure 41) shows how the data flows from one protocol to another. Since each 

protocol groups parameters differently, there is no one-on-one relationship between NMEA 0183 

sentences, NMEA 2000 PGNs and SeaTalk datagrams. Every single parameter like a position, COG, SOG 

etc. is therefore decoded from the received sentences, PGNs and datagrams and stored in a database 

first. 

From this database, the parameters are retrieved and grouped to build new sentences, PGNs and 

datagrams. Their route is determined, and they are transmitted again. 

See the Technical Reference starting on page 78 for an overview of all converted NMEA 0183 

sentences, NMEA 2000 PGNs and SeaTalk datagrams. 

 

Figure 41 

NMEA 0183 and SeaTalk to NMEA 2000 
This conversion is very straightforward: Every received NMEA 0183 sentence or SeaTalk datagram is 
converted to NMEA 2000. No routing is applied since every NMEA 2000 receiving device has a means of 

selecting a data source. 

Similar data from two or more NMEA 0183 or SeaTalk inputs on the MiniPlex-3 appears on the NMEA 

2000 network as originating from different virtual devices. 

NMEA 2000 to NMEA 0183 
This conversion is controlled by the routing table or the Default Route* settings. NMEA 2000 data is 

converted into NMEA 0183 sentences, which can then be routed to any NMEA 0183 output or host 
interface as desired. If no match is found in the routing table or when the routing table is empty, the 

Default Route is applied. This is explained in detail in chapter Routing on page 61. 

NMEA 2000 and NMEA 0183 to SeaTalk 
These conversions are fully controlled by the routing table. None of the received NMEA 0183 or NMEA 

2000 data is converted and routed to SeaTalk by default. Each sentence that must be routed/converted 

to SeaTalk requires an entry in the routing table. 

 

* The Default Route is the route applied to a sentence when no match is found in the routing table. The Default Route 
is set by checkboxes in section Input Settings on the NMEA Inputs/Outputs tab. 
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SeaTalk to NMEA 0183 
This conversion is controlled by the routing table or the Default Route* settings. SeaTalk data is 

converted into NMEA 0183 sentences, which can then be routed to any NMEA 0183 output or host 

interface as desired. If no match is found in the routing table or when the routing table is empty, the 

Default Route is applied. This is explained in detail in chapter Routing on page 61. 

NMEA 2000 and SeaTalk in the Routing Table 
In NMEA 0183 sentences, the address field is the first field that follows the “$” or the “!” delimiter. Since 
these address fields are fairly readable for human beings, they are also used to identify SeaTalk and 

NMEA 2000 data in the routing table of the MiniPlex-3, as opposed to NMEA 2000 PGN numbers or 

SeaTalk datagram numbers. 

This address field consists of five characters: the first two are the Talker ID and the last three characters 
are the Sentence Formatter. The Talker ID defines the origin of a sentence whereas the Sentence 

Formatter defines the type of data the sentence contains. 

A $GPRMC sentence for instance defines “GP” as its source (a generic GPS) and “RMC” as a sentence 

containing a full position fix, its time and date and the current course and speed over ground.  

Similarly, a $HEHDT sentence define “HE” as its source (a heading device) and “HDT” as a sentence 

containing a true heading. A $GPHDT sentence defines a true heading originating from a GPS compass. 

The Technical Reference starting on page 78 contains a list of commonly used sentence formatters and 

talker IDs. 

Autopilot Control 
Autopilot control data* is converted using a fixed priority from high to low: NMEA 2000 > NMEA 0183 > 

SeaTalk. 

When autopilot control data is received on one protocol, it will be automatically converted to both other 
protocols using the same rules as used for other navigation data: SeaTalk and NMEA 0183 are always 

converted to NMEA 2000 whereas NMEA 2000 to NMEA 0183 and/or SeaTalk is governed by routing 

rules. 

The big difference is the prioritization of this data from multiple sources: when an NMEA 0183 connected 
plotter and an NMEA 2000 connected plotter both have an activated route to Goto, then only the data 

from the plotter on NMEA 2000 is converted to NMEA 0183.  

Similarly, a plotter on SeaTalk doesn’t get its autopilot control data converted when the same data is 

being received from NMEA 0183 or NMEA 2000. 

The idea behind this is that only one plotter at a time can control an autopilot. After all, there can be only 

one captain on a ship! 

Multiple sources of autopilot control data on NMEA 2000 are prioritized by Source Address (SA) or Device 

Instance (DI). Prioritization by DI only works when the DI’s of all sources are non-zero. In both cases (SA 

or DI), a lower value has higher priority. 

Since the DI of a device can be changed, navigation sources can be prioritized by the user. 

  

 
* Autopilot control data is contained in NMEA 2000 PGN’s 129283, 129284 and 129285, NMEA 0183 sentences APB, 

BWC, BWR, RMB, WCV and XTE, and in SeaTalk datagrams 82, 85, A1 and A2. 
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Power Supply 
The MiniPlex-3 must always be powered through its PWR (+ & -) terminals with a DC voltage between 8 

and 35V. The power supply connection is protected against reversed polarity. 

The MiniPlex-3 does not receive power from the USB port, the SeaTalk port or the NMEA 2000 

network! 

Indicators 
The LEDs on the MiniPlex provide information about the status and operation of the MiniPlex-3. When the 

MiniPlex-3 powers up, all LEDs flash once. 

Green (NMEA 2000): This LED flashes when an NMEA 2000 PGN is received. 

Green (NMEA 0183): This LED flashes upon reception of a valid NMEA sentence. During a firmware 

update, this LED flashes upon reception of a firmware block. 

Yellow (WiFi models): This LED is lit when the WiFi interface is up and running. 

Red (Overflow): This LED flashes on a NMEA output buffer overflow, indicating that NMEA sentence 

will be lost due to bandwidth limitations. 

During start-up, this LED is lit for a short moment while the MiniPlex-3 checks if 

firmware is loaded or if a firmware update is initiated by MPXConfig3. If firmware 

is found, the LED goes off. When the LED stays lit, no firmware was found. 
During a firmware update, this LED is on. When the update is completed, the LED 

goes off. If the LED stays on after a firmware update error, it indicates that no 

valid firmware is present. 

Data Throughput 
A MiniPlex-3 can combine several streams of data into one, but it cannot perform magic. It is obvious 

that if a MiniPlex-3 combines NMEA 0183 sentences from multiple sources, the total number of sentences 

that must be transmitted is the sum all sentences received from each source. So, any output port that 

needs to transmit these sentences must have sufficient bandwidth to do so. 

The Host ports are all high speed and fast enough to transport all possible NMEA 0183 and NMEA 2000 

data that is being received to a connected host. The NMEA 0183 outputs however are not! 

The standard communication speed of NMEA 0183 is 4800 Baud or bits per second, which equals 480 

characters per second. 

When using a MiniPlex-3 to combine sentences from several sources, it is easy to create a situation in 

which more data is being received than can be transmitted through an NMEA 0183 output because of the 

speed limitations of that output. This will inevitably lead to an overflow of the output buffers inside the 

MiniPlex-3. 

Each output buffer can hold 512 bytes of data, which is slightly more than 1 second worth of data at 

4800 Baud. 

When a received sentence is routed to Out1 or Out2, it is stored in the corresponding output buffer, from 

where it is transmitted to the physical output port. Because of the limited size of this buffer, it is obvious 
that it will overflow if the buffer is filled faster than it is emptied. While it might seem a good solution to 

increase the buffer size to prevent overflows, it is not. It only delays the point at which this larger buffer 

is filled up too. It just takes a longer time. 

With NMEA 0183, sentences are usually transmitted once per second (exceptions exist). It therefore 
makes sense to limit the size of the buffers to store one second worth of data. This also limits the delay 

of transmitted sentences to one second max. If more sentences need to be transmitted than a buffer can 

hold, they are simply no longer being added to that buffer. 

Note that sentences are never dropped when being sent to a host port. The speed of a host port is 100 
times higher than an NMEA 0183 port at 4800 Baud and two times higher than the speed of NMEA 2000, 

so it will never pose any throughput limitation. If a sentence is routed to a host port and an NMEA 0183 

output, and the buffer of that output is full, that sentence will still be routed to the host port. 

A buffer overflow event is signalled by the red LED on the MiniPlex and by the overflow indicators in 

MPXConfig3. 

All of the above may raise the question if it is possible at all to combine data from four inputs at 4800 

Baud and still transmit this on an output at 4800 Baud. 
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It depends… 

The standard speed of an NMEA 0183 port is 4800 Baud or bits per second, representing 480 characters 

per second (10 bits are needed for one character). It might seem obvious that combining four NMEA 

0183 streams at 4800 baud would require the output to be operating at 4 x 4800 = 19200 Baud to 

prevent any data loss. 

In general, devices do not send a continuous stream of NMEA sentences. A wind instrument for instance, 

typically transmits one $WIMWV sentence per second and the length of this sentence will be 30 characters 

at most. Thus, the occupied bandwidth of this device is 30 char/s, leaving room (450 char/s) for 

sentences from other devices. 

On the other hand, a GPS can transmit $GPRMB, $GPRMC, $GPGLL, $GPGGA, $GPVTG, $GPZDA, $GPGSA and 

$GPGSV (3x). This is a burst of 10 sentences which already exceeds the bandwidth of 480 char/s when 

transmitted every second. Such a GPS would typically transmit these sentences once every two seconds. 

So, it totally depends on the kind of sentences received - their length and frequency – whether they can 

be combined and transmitted on an output operating at 4800 Baud. Simply increasing the speed of that 
output is often not possible because the receiving device might not have a means of increasing the speed 

of its input port.  

There are several ways to resolve buffer overflow and loss of sentences: 

1. Configure the instruments connected to the inputs of the MiniPlex-3 to send less sentences or at a 

lower rate. GPS receivers usually offer a selection of sentences to be transmitted. 

2. Use the routing table of the MiniPlex-3 to block unwanted sentences. 

3. For sentences that should not be blocked, setting a divisor in the routing table may reduce their rate 

or frequency. The output of a compass at rate of 10Hz can thus be throttled down to a lower rate. 

4. Increase the speed of the NMEA 0183 output that suffers from overflows. This will only work when 

the receiving equipment also supports higher communication speeds. Connected ports must always 

match their communication speed (Baud rate). 

In any case: a blink of the red LED means loss of data. If that occurs once every few seconds, it might 
not be a problem at all. But a blink every second or even faster means that one or more sentences will be 

lost all the time. 
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MPXConfig3 
The MiniPlex-3 multiplexer is configured with a tool called MPXConfig3. This tool can be found on the 

accompanying CD and can also be downloaded from the Downloads page on our website. It is available 

for Windows and macOS. 

There is no installer for this tool. It can be started directly from the CD or from the downloaded ZIP file or 
disk image. It is however a good practise to copy the program to a suitable folder on your hard-disk and 

create a shortcut on your desktop. 

The MiniPlex-3 itself is configured with proprietary NMEA 0183 sentences. MPXConfig3 transmits these 

sentences to the MiniPlex-3 immediately when you change a setting. 

Settings do not have to be stored explicitly except for the routing table. 

All configuration settings are stored in non-volatile memory of the MiniPlex-3. These settings are retained 

without power supply. 

 

Figure 42: The MPXConfig3 main window 

 

The window of MPXConfig3 is divided into four sections from top to bottom: the menu, the NMEA viewer 
and its controls to the right of it, the controls to configure MiniPlex-3 on the lower half of the window, and 

the status bar. 

The NMEA viewer shows the NMEA 0183 sentences transmitted by the MiniPlex-3 to its host port(s). 

These sentences include NMEA sentences received on its inputs (NMEA 0183, SeaTalk and NMEA 2000) 

as well as status messages generated by the MiniPlex-3 (sentences starting with $PSMD). 

The controls on the tabbed pages determine the operation and configuration of the 

MiniPlex-3 and are grouped according to their function. 

The status bar shows the name or type of the connected MiniPlex-3, its firmware version number and its 
serial number. This information is useful when you require technical support. Also shown are the 

optionally loaded or saved configuration file and a line counter when a log file is being created. 
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Menu 
The menu contains two sub-menus: File and Tools. Some options of these menus are disabled or not 

visible, depending on the type of connected MiniPlex-3 or on the status of the connection. 

The File menu offers the following choices: 

Log NMEA… Start writing NMEA data to a log file. A log file is a plain text file and can 

read by any text editor to examine the data. The Log counter on the 

status bar will show the number of NMEA sentences that are currently 

written to the log file. 

Log Diagnostic Info… Start writing to a log file with the addition of a time stamp at the 

beginning of each NMEA sentence. 

Stop Log Stop writing NMEA data to the current log file and close that file. 

Load Configuration… Load a previously saved configuration file into the MiniPlex-3. The 

current configuration will be overwritten. A configuration file stores all 

settings made with MPXConfig3. 

Save Configuration Save the current configuration to a previously file. 

Save Configuration As… Save the current configuration to a new file. 

Update MiniPlex Firmware… Load new a firmware file into the MiniPlex-3. 

Exit This exits MPXConfig3. 

The Tools menu offers the following choices: 

Show Statistics Opens a window showing bars that indicate how much data is stored in 

the database, the NMEA 2000 queues and the processing time for 

conversions. 

MiniPlex-3E Opens a sub-menu for the MiniPlex-3E (only present when TCP or UDP is 

selected with the Port selector). 

MiniPlex-3Wi Opens a sub-menu for the MiniPlex-3Wi (only present when connected to 

a MiniPlex-3Wi(-N2K) via USB. 

Restore Factory Settings… Restore the MiniPlex-3 to its default factory configuration. 

Automatic Update Update the firmware in the MiniPlex with the firmware embedded in 

MPXConfig3. This is the minimum required firmware version compatible 

with this version of MPXConfig3. 

About Show a window with version information. If you double-click on the 
multiplexer icon in this window, MPXConfig3 will erase all settings stored 

in the Windows registry and exit. Only settings like port number and IP 

address are stored in the registry. No multiplexer settings are stored 

there. 

The MiniPlex-3E sub-menu is only present when TCP or UDP is selected with the Port selector and offers 

the following choices: 

Network Setup… Open a window to setup the network parameters of a MiniPlex-3E. 

Search… Search the network for MiniPlex-3Es. A window is shown with search 

results. 

Assign IP… Assign an IP address to a MiniPlex-3E using its MAC address. 

Please note that this sub-menu is for the MiniPlex-3E(-N2K) only. It does not change any 

network settings of the MiniPlex-3Wi(-N2K) nor does it find any MiniPlex-3Wi(-N2K)! 

The MiniPlex-3Wi sub-menu is only present when connected to a MiniPlex-3Wi(-N2K) via USB and offers 

the following choices: 

Setup WiFi Parameters… Open a window to setup the WiFi parameters of a MiniPlex-3Wi. 

Initialize WiFi Interface… Initializes the WiFi interface to our factory settings. 
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MiniPlex Connection 
Before being able to configure the MiniPlex-3, MPXConfig3 must be connected to the MiniPlex-3. Use the 

Port selector to select either the COM port of the MiniPlex-3 or TCP or UDP when using a network 

connection. Do not use UDP All for configuration purposes. 

COM Port 
When using a MiniPlex-3 with a USB port, select the COM port 

that was created after installing the driver. Click on the Connect 

button to initiate the connection. MPXConfig3 will immediately 

read the current configuration from the MiniPlex-3. 

Note that only one application at a time can connect to a COM 

port. You cannot connect MPXConfig3 and a navigation 

application at the same time. The only exception is when using a 

MiniPlex-3Wi: while one application connects using a network 
connection, a second application can connect using the USB/COM 

port. 

Network 
When connecting to a MiniPlex-3E, set the Port selector to UDP and follow the instructions in chapter 

Ethernet Interface on page 19 to setup the network parameters of the MiniPlex-3E. 

When this setup is completed, select TCP or UDP to match the 

protocol set in Network Settings. 

Enter the IP address of the MiniPlex-3E in the Host field or use 

menu Tools > MiniPlex-3E > Search to find the MiniPlex-3E on 

your network. 

When connecting to the access point of a MiniPlex-3Wi, select 

either TCP or UDP, enter IP address 10.0.0.1 in the Host field.  

The Port field already contains port number 10110, which is the 

standard NMEA 0183 port value. When left blank, port 10110 is automatically assumed. 

Click on the Connect button to initiate the connection. MPXConfig3 will immediately read the current 

configuration from the MiniPlex-3. 

UDP All 
Besides TCP and UDP, the Port selector also contains UDP All. This connection method will show NMEA 

0183 data from all devices that is broadcast on the network. No configuration will be read, and all 

configuration controls will be shown inactive. 

The Host field must contain a valid IP address of a MiniPlex-3. When a connection is established, 

MPXConfig3 will request the $PSMDVER sentence from that MiniPlex-3. If the Host field contains the 

network broadcast address (e.g. 192.168.1.255), the $PSMDVER sentences of all MiniPlex-3 devices on the 

network are returned. 

Using the Send NMEA field, a command can be sent to one or all MiniPlex-3 devices, depending on 

whether the Host field contains a host IP address or a broadcast IP address. 

Reading the configuration 
When the Connect button is clicked, MPXConfig3 opens a connection to the MiniPlex-3 and automatically 

retrieves its current configuration. The tabbed configuration pages will be enabled upon success and the 

LED on the Connect button will become green. Depending on the type and/or configuration of the 

connected MiniPlex-3, the NMEA 2000, Modbus and MOB tabs may or may not be visible. 

Error messages may appear when attempting to connect. These messages may be helpful in determining 

the problem: 

Multiplexer does not respond 

You have selected the wrong COM port or entered the wrong IP address in case of a UDP connection. 

Unable to open port COMx, the port may be in use 

The COM port you are trying to open, is already being used by another application. 

Connect timed out 

You have entered the wrong IP address when trying to open a TCP connection. 

Figure 43 

Figure 44 
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Socket Error # 10061, Connection refused 
The IP address is correct but the MiniPlex-3E refused the TCP connection. This happens when another 

application has already opened a TCP connection or when the MiniPlex-3E was configured for UDP. 

Could not bind socket. Address and port are already in use 

Another application has already used port 10110 for UDP. Using UDP requires an application to bind to 
a port number to receive all UDP traffic on that port number. A port number can only be bound to one 

application at a time. 

If you exit MPXConfig3, the connection settings will be saved and reloaded when MPXConfig3 is started 

again. When you select a different port while being connected, MPXConfig3 closes the current connection. 

You can also force MPXConfig3 to retrieve the configuration from the MiniPlex-3 with the Read 

Configuration button (Figure 45). 

Send NMEA 
MPXConfig3 allows manual entry of arbitrary NMEA sentences for testing, configuration etc. 

Type the desired NMEA sentence in the edit box and click on the Send button or press the Enter key on 

your keyboard to transmit the sentence to the MiniPlex-3. MPXConfig3 will keep a history of entered 
sentences/commands. These can be selected by clicking on the small arrow on the right side of the input 

field. A selected sentence can be transmitted again by clicking on the Send button or pressing the Enter 

key. It can also be edited prior to transmitting. The Clear button clears the history. 

Preceding the NMEA sentence with a “$” is optional, MPXConfig3 
will add it for you if omitted. The input is case sensitive, so 

whatever you type will be transmitted to the MiniPlex-3 verbatim. 

Since all standard NMEA sentences are uppercase, you must enter 

them as uppercase. 

Any sentence starting with $PSMD will be recognized by the 

MiniPlex-3 as a configuration command and will be processed as 

such. Any other sentence will be routed to any NMEA output which has its Host Data set to Yes or 

Override. Routes specified in the routing table will be applied too. This allows specific configuration 

sentences to be transmitted to connected devices. 

This feature can also be used to test if an NMEA input or output is functional: Connect an NMEA output to 

an input, set Host Data for that output to Yes and type an arbitrary text of at least 6 characters in the 

Send NMEA field. This text should appear in the NMEA viewer when you click on the Send button or 

press the enter key. 

View Options 
The NMEA Viewer area (Figure 46) offers a few controls that make observing NMEA data 

easier. 

The NMEA viewer itself stores up to 100 sentences which can be scrolled back 

(disconnect first). These sentences can also be copied and pasted into another 

application (Windows only). 

Clear 
This button clears the NMEA Viewer window. 

No Scroll 
When this option is enabled, a list of received NMEA sentences will be displayed, which 

will refresh continuously when new sentences are received. This feature allows you to 
closely examine the types of sentences received from the connected instruments. Any 

proprietary NMEA sentences that are generated by the MiniPlex-3 are also listed. These 

sentences start with $PSMD. 

Tag Blocks 
This option shows any TAG blocks that precede a sentence. TAG blocks are enabled when MPXConfig3 is 

connected to the MiniPlex-3. MPXConfig3 uses these TAG blocks to identify the source of a sentence 

(NMEA 0183 input or NMEA 2000 Source Address) and to add a time stamp to each sentence. 

When a device connected to the inputs of the MiniPlex-3 transmits TAG blocks, they will also be visible. 

Figure 45 

Figure 46 
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Source selector 
The Source selector allows you to selectively see sentences from one specific NMEA input of the MiniPlex-

3, the NMEA 2000 network, conversion results or responses from the multiplexer itself. 

Overflow 
The overflow indicators show which output buffer suffers from an overflow. See the chapter Data 

Throughput on page 42 for ways to prevent overflow situations with different instruments. 

  



 

49 

NMEA Inputs/Outputs 
This tab contains all settings dealing with inputs and outputs of the MiniPlex-3 and the default routing 

settings. Each setting is described in detail below. 

 

Figure 47 

Input Settings 

Speed 
This sets the speed of each NMEA 0183 input. The default speed is 4800 Baud, which is the standard 

speed for navigation devices. The highest supported speed is 115200 Baud. 

Some fluxgate or gyrocompasses operate at 9600 Baud or faster to accommodate the higher throughput 

of 20 headings per second or more. AIS receivers and transponders operate at 38400 Baud. 

If you change the speed of In4, the speed of Out1 will be changed too. In4 and Out1 share the same 

communication port inside the MiniPlex-3 and therefore always have the same speed. Out1 is generally 

used to control an autopilot and should be left at 4800 Baud for this purpose. 

If the Input Mode of In1 is set to SeaTalk, the speed setting for In1 is disabled and fixed to 4800 Baud, 

which is the standard speed on the SeaTalk network. 

Care should be taken when inputs are set to higher speeds than the outputs which they are routed to. 

This can possibly lead to buffer overflows. See the chapter Data Throughput on page 42 for more 

information. 

Talker ID 
The MiniPlex-3 can change the Talker ID of received sentences. The first two characters of an NMEA 

sentence are the Talker ID of that sentence, indicating the source of the data being transmitted. 

For instance, in an $HEHDT sentence, the “HE” identifies the source of this true heading sentence as a 

gyro compass. In a $GPHDT sentence, the “GP” identifies the source as a GPS based compass. 

Similarly, a device with both a GPS receiver and a Galileo receiver has a Talker ID “GP” when the position 

is GPS based, “GA” when the position is Galileo based, and “GN” for a combined navigation position from 

both Galileo and GPS. 

Changing the Talker ID of a sentence can be required for instance when using a GPS compass. Such a 

compass generally transmits the true heading as a $GPHDT sentence. A receiving device or application 

might however require a true heading with Talker ID “HE”. By entering “HE” in the Talker ID field of the 

input connected to the GPS compass, the received $GPHDT sentence will be changed into $HEHDT. 

Setting a Talker ID can also be useful when similar devices are connected to the multiplexer while the 

navigation software must be able to distinguish between the data from these devices. A catamaran for 

instance could have a depth sounder in each hull, both transmitting $SDDPT sentences to the navigation 

software. Setting the Talker ID for those inputs to “H1” and “H2” respectively would change these 

sentences into $H1DPT and $H2DPT, allowing the receiving software to recognise both depth readings 

separately. 
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Enter the Talker ID in the edit box of the desired input and press the Enter key to send the setting to the 
multiplexer. A Talker ID should have upper case characters and numbers only. See the Technical 

Reference section for an overview of the most commonly used Talker IDs. 

When the Talker ID is changed, the background of the edit field turns yellow to indicate that de modified 

Talker ID has not yet been sent to the multiplexer. Pressing Enter will send all Talker IDs to the 
multiplexer and the background colour will return to white. It is possible to change all Talker IDs first and 

press Enter after changing the last one. Starting at the Talker ID field of input 1, pressing the Tab key 

will jump to the Talker ID of the next input. 

Clicking the Read Configuration button will read the Talker ID settings from the multiplexer. Any 
modified Talker IDs that have not been sent to the multiplexer (yellow background) will revert to their 

original values. To clear a Talker ID, simply clear the edit box by selecting the contents with the cursor 

and press the Del or Backspace key on your keyboard and finally press Enter. An empty Talker ID setting 

will show two dashes. 

The MiniPlex-3 will only change Talker IDs of approved NMEA 0183 sentences. Proprietary sentences 

starting with “$P” or “!P” will remain untouched, because these sentences have no Talker ID field. 

There is no Talker ID setting for NMEA 2000 sources. It would be quite useless to set a Talker ID for an 

entire set of navigation data.  

Priority 
Each NMEA 0183 input of the MiniPlex-3 can be assigned a priority from 1 to 5. 1 sets the highest priority 

and 4 sets the lowest. By default, no priority is set (“--”). There is no priority setting for the conversion 

results as these will have the same priority as the input receiving the source of the conversion. 

On NMEA 2000 enabled models, the range of priority values is extended up to 200. The higher values 10, 

20, 50, 100 and 200 can be used for prioritizing against higher and fixed Device Instance numbers of 

devices on an NMEA 2000 network. 

An overall priority can be assigned to NMEA 2000 sources. Setting the priority of the NMEA 2000 port to 

1 to 5 will assign this priority to all sources on the NMEA 2000 network. By selecting “DI” however, 

individual sources on the NMEA 2000 network can be assigned a priority by setting their Device Instance* 

to a non-zero value. When set to 1 or higher, the Device Instance value is compared against the priority 
values of the NMEA 0183 inputs, and the same check is applied: a lower value has a higher priority. To 

be able to prioritize from NMEA 2000 sources that don’t allow their Device Instance to be changed, the 

NMEA 0183 inputs can be set to higher values in the range of 5 to 200. 

Assigning a priority to at least two inputs or NMEA 2000 sources will cause the MiniPlex-3 to block 
duplicate NMEA 0183 sentences received/generated from the lowest priority source. If a duplicate 

sentence from the higher priority source is no longer received, the same sentence from the next lower 

priority source will be passed after an adjustable time out in the Priority Control panel. 

Only the Sentence Formatter (e.g. the “RMC” part) is used for comparison - the Talker ID (the “GP” part) 

is ignored. 

Example 1: two GPS receivers are connected to In1 and In2 with priority settings of 1 and 2 respectively. 

Both GPS receivers transmit $GPRMC sentences but only those from the GPS on In1 are passed. This 

feature can be useful to set up a second GPS as a backup for the main GPS. 

Example 2: a GPS and an AIS are connected to In1 and In2 respectively. By assigning a lower priority to 

In2, the duplicate GPS sentences from the AIS will be blocked. 

Note that the priority system does not block an entire input; it only blocks duplicate sentences. 

Sentences received from the AIS like! AIVDM, which are not received from the GPS, are passed. 

Table 1 shows sentences from the GPS on In1 and from the AIS transponder 
on In2. The higher priority of the GPS input blocks the greyed GPRMC 

sentence received from the AIS transponder. 

The priority system can store up to 50 different sentence types to determine 

their priority. An adjustable time out ensures that sentences received from 
lower priority sources are passed again when their duplicates from higher 

priority sources are no longer received or have an invalid Status Flag. 

Example 3: On the NMEA 2000 network are two sources of GPS data, a mast 

mounted GPS antenna and a chart plotter. If the mast mounted GPS must be the primary source of GPS 

 

* The Device Instance of a device can be changed using the NMEA 2000 Device List. On tab NMEA 2000, click on 
button Device List, double-click on the desired device from the list and change the Device Instance in the Device 
Information window that appeared. 

GPS 

(In1) 

AIS 

(In2) 

GPRMC GPRMC 

GPGGA AIVDM 

 
Table 1 
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data and the chart plotter the secondary source, set the Device Instance of the mast mounted GPS to 1 
and the Device Instance of the chart plotter to 2. If the mast mounted GPS transmits GPS data on the 

NMEA 2000 network, the MiniPlex-3 will use this GPS as the source to convert the NMEA 2000 data to 

NMEA 0183 sentences. When the mast mounted GPS fails or loses fix, the MiniPlex-3 will fall back to 

using the chart plotter as conversion source. 

Priorities of NMEA 0183 inputs and NMEA 2000 devices the network can be mixed: the priority value of 

each NMEA 0183 input is compared directly to the Device Instance of NMEA 2000 data sources. 

The Device Instance of an NMEA 2000 device can be changed in the Device List of MPXConfig3 or on any 

chart plotter that is connected to the NMEA 2000 network. 

Input Mode 
The NMEA 0183 inputs of the MiniPlex-3 can be set to different modes besides standard NMEA, to be able 

to receive “not quite standard” NMEA, plain text or SeaTalk. The following modes are available: 

NMEA: Normal NMEA processing. This is the default processing mode in which sentences are 

checked for correct formatting according to the NMEA 0183 standard. Any sentence 

that is incorrectly formatted or has a checksum error is rejected. This behaviour meets 

the IEC/EN60945 requirements. 

NMEA (ERR): Forward NMEA sentences with a checksum error unmodified, bypassing all further 

NMEA processing, routing and conversions. Only the default route is applied. This 

allows other devices or software to detect the checksum error. 

NMEA (CR/LF): Relaxed NMEA format checking. This mode will accept incorrectly terminated 
sentences. Using this mode, a sentence is considered terminated if it ends on a CR, a 

LF or a combination of both in arbitrary order. 

Text to NMEA: Receive plain text strings and forward them as $MXTXT sentences. Any character with 

an ASCII value greater than 32 (a space) is regarded as the start of a string. The 

string must end on a CR or LF and its length may not exceed 61 characters. A longer 

string will result in a new $MXTXT sentence containing the remainder of the string. Only 

valid NMEA characters are read. Invalid characters are stripped from the received 

string. 

The Total number and Sentence number fields of the $MXTXT sentence are always set 

to “01”. The Text Identifier field of the $MXTXT sentence contains the input number on 

which the string was received. When for instance “Hello World” is received on input 3, 

the resulting sentence will be: $MXTXT,01,01,03,Hello World*6E. 

Text to PTXT: Receive plain text strings and forward them in $PTXT sentences. Any character with an 

ASCII value greater than 32 (a space) is regarded as the start of a string. The string 
must end on a CR or LF and its length may not exceed 71 characters. A longer string 

will result in a new $PTXT sentence containing the remainder of the string. The 

MiniPlex-3 will always terminate a forwarded string with a CR/LF pair. 

All characters with an ASCII value from 32 to 127 are forwarded. 

Plain Text: Receive plain text strings and forward them unmodified. Any character with an ASCII 
value greater than 32 (a space) is regarded as the start of a string. The string must 

end on a CR or LF and its length may not exceed 77 characters. A longer string will 

result in a new string containing the remainder of the original string. The MiniPlex-3 

will always terminate a forwarded string with a CR/LF pair. 

All characters between from ASCII 32 to 127 are forwarded. 

SeaTalk: Available on In1 only. This mode switches In1 to SeaTalk mode and fixes its speed to 

4800 Baud. When this mode is selected, In1 becomes a fully bi-directional SeaTalk 

port which can receive and transmit SeaTalk data. See the Technical Reference 

section for an overview of the converted SeaTalk datagrams. 

SeaTalk-STNG: Available on In1 of NMEA 2000 models only. This mode switches In1 to SeaTalk mode 

with Raymarine SeaTalk-STNG converter emulation and fixes its speed to 4800 Baud. 

When this mode is selected, In1 becomes a fully bi-directional SeaTalk port which can 
receive and transmit SeaTalk data. Conversions of SeaTalk control datagrams is also 

supported, like Raymarine's own SeaTalk-STNG converter. This allows for instance a 

SeaTalk remote control to be used to control a SeaTalkNG autopilot. This mode should 

not be used when a Raymarine SeaTalk-STNG converter is already present on the 
SeaTalkNG/NMEA 2000 network, because this would result in a data-loop, flooding the 

SeaTalk bus with control messages. See the Technical Reference section for an 

overview of the converted SeaTalk datagrams. 
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Input “NMEA Conversions” 
The results of NMEA 0183 conversions (see the Conversions tab, Figure 51) are available through this 

“virtual” input if the conversion result has the same Sentence Formatter as the originating sentence. 

These sentences can be routed using the default route settings and the routing table, using input column 
C. Conversion results with a different Sentence Formatter originate from the same input as the original 

sentence. 

Input “NMEA 2000” 
NMEA 2000 PGNs are converted into NMEA 0183 sentences, which are processed in the same way as 
NMEA 0183 sentences received on In1 to In4. They can be routed using the default route settings and 

the routing table, using input columns N and Device. 

Default Route 
These options enable a default route from the NMEA 0183 inputs, the NMEA 2000 port and the conversion 

results to the NMEA 0183 outputs. 

The default route is applied to a sentence when no specific route for this sentence exists in the routing 

table. A match in the routing table always takes precedence over the default route. 

There is always a default route from the NMEA 0183 inputs and NMEA 2000 port to the host port(s). 

Output Settings 

Speed 
This sets the speed of each NMEA 0183 output. The default speed is 4800 Baud, which is the standard 

speed for navigation devices. The highest supported speed is 115200 Baud. 

If an output is connected to a plotter, it is wise to set this output and the input of the plotter to a higher 

speed to prevent output buffer overflows. Especially when many sentences/inputs or an AIS source are 
routed to that output, it is essential to choose at least 38400 Baud. Most plotters support a speed of 

38400 Baud or higher. 

If you change the speed of Out1, the speed of In4 will be changed too. In4 and Out1 share the same 

communication port inside the MiniPlex-3 and therefore always have the same speed. Out1 is generally 

used to control an autopilot and should be left at 4800 Baud for this purpose. 

Host Data 
These settings control if and how sentences from the host interfaces USB, Ethernet or WiFi are routed to 

each NMEA output: 

No: No sentences from the host interface are routed to the NMEA output. 

Yes: Sentences from the host interface are routed to the NMEA output and mixed with sentences 

from the inputs, SeaTalk and NMEA 2000. 

Override: Sentences from the host interface are routed exclusively to the output and take precedence 

over any sentence from the inputs, SeaTalk and NMEA 2000. When the host sends sentences 

to the MiniPlex-3, no other sentences are routed to that output. When the host stops sending 

sentences however, sentences from the inputs, SeaTalk and NMEA 2000 will be routed to the 

output again after a time out of 10 seconds. 

The Override option is very useful when navigating alternately using a GPS and navigation software. 

Consider a typical set-up as shown in Figure 48 with Out1 set to Override: 

 

Figure 48 
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The connected laptop will receive all data from the instruments. If a waypoint or route is activated in the 
navigation software, it will transmit autopilot-control sentences to the MiniPlex-3. These sentences will be 

routed to Out1 exclusively. The connected autopilot will therefore receive sentences from the navigation 

software only. 

If the laptop is not connected, or if no route is activated in the navigation software and it is not 
transmitting any sentences, the MiniPlex-3 will automatically route sentences from the inputs to Out1, 

thus allowing the GPS to control the autopilot.  

Output NMEA V1.5 
NMEA Out2 has an option to convert specific sentences from NMEA 0183 V2.0 and up to V1.5 format. 

NMEA 0183 V2.0 and up defines new fields that are added to existing sentences. Also, in NMEA 0183 

V1.5 magnetic heading is transmitted using an HDM sentence instead of an HDG sentence. 

Some older navigation devices can only process NMEA 0183 V1.5 sentences and refuse to receive/decode 
newer sentences. If this option is enabled, the MiniPlex-3 converts the following sentences to NMEA 0183 

V1.5 format: 

ABP, BWC, BWR, GGA, GLL, HDG, RMA, RMB, RMC, VBW, VLW, VTG, XTE and ZDA. 

The HDG sentence is replaced by an HDM sentence, and in the VTG sentence the decimal point and 

trailing decimals are removed from both course fields (older B&G equipment requires this). 

Note: this option only affects sentences transmitted from NMEA Out2! 

Ignore Divisor 
This option disables the divisor in a routing table entry for NMEA Out2. When enabled, sentences are 
transmitted at their original frequency or rate. The divisor is still applied to the same sentences routed to 

NMEA Out1. 

Priority Control 
Two settings on the Priority Control panel govern the behaviour of the Priority system: Check GPS 

status and a Time out value in seconds.  

When the Check GPS status option is enabled, the status and mode flags of GPS sentences are 

checked. If these flags indicate an “invalid” status (e.g. No fix or Simulator mode), the sentence is 
blocked. This causes the priority system to choose the next available, lower priority source of like 

sentences. Without this option enabled, the primary GPS must completely fail (i.e. stop transmitting 

data) before sentences from the secondary GPS are passed. 

Sentences checked for valid status and mode flags are APB, GGA, GLL, RMA, RMB, RMC, VTG and XTE. In 
addition, the heading field of HDT sentence is checked. Since the HDT sentence has no status flag, GPS 

compasses generally leave the heading field blank when a GPS fix is lost. 

NMEA 2000 PGNs which contain a status field, such as PGN 129209 (GNSS Position) are also checked.  

The Time out setting determines when a similar sentence of the next lower priority source will be 

passed. The time out can be set from 1 to 30 seconds. 
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Options 
On this tab, several options can be enabled as well as NMEA 0183 sentences that are generated from 

NMEA 2000 and SeaTalk. 

 

Figure 49 

General Options 

AIS MOB Alarm 
The MiniPlex-3 has an AIS MOB alarm feature, which responds to AIS-SART messages from AIS-based 

SART, MOB and EPIRB devices. To receive these AIS-SART messages, an AIS transponder or receiver 

must be connected to the MiniPlex-3, either via NMEA 0183 or NMEA 2000. When this option is enabled, 
an AIS MOB Alarm tab will appear, which contains the AIS MOB table and buttons to manage the table. 

The AIS MOB Alarm feature is described in detail in chapter AIS MOB Alarm on page 71. 

AIS Own Position to GPS data. 
This option converts the so-called Own Vessel Report received from an AIS transponder to GPS data. The 

Own Vessel Report may be received on NMEA 0183 or NMEA 2000. The converted GPS data is 

transmitted from virtual input Conversions on NMEA 0183, NMEA 2000 and - when enabled - via the 

routing table on SeaTalk. 

The own vessel position report only contains latitude, longitude, course and speed over ground. No time 

and date are available. Therefore, the generated GPS position does not have a time or date of fix. 

Raw SeaTalk (PSMDST) 
This option enables conversion of SeaTalk datagrams to $PSMDST sentences containing the unconverted 

“raw” SeaTalk data. The $PSMDST sentence contains hexadecimal numbers for each byte of the original 

SeaTalk datagram. For normal use of the MiniPlex-3, this option should be left disabled as it is only 

intended for either diagnostic purposes or for software developers who want to have access to all 

available SeaTalk datagrams on the network. 

For an in-depth technical explanation of this option, see paragraph Converted SeaTalk Datagrams in 

the Technical Reference in the back of this manual. 

SeaTalk Depth in meters 
When depth information from NMEA 0183 or NMEA 2000 is converted and routed to SeaTalk, this option 

will instruct displays on the SeaTalk network to show the depth in meters instead of feet. 

Suppress GPS Pinning 
Modern GPS receivers may not transmit course over ground and even speed over ground when the GPS 

is not moving. This is called pinning. When a GPS is stationary, a COG cannot be determined, thus it has 
a random value while the SOG might be either 0 or a very small but varying value. Pinning suppresses 

these random values by marking the data as “not available” in NMEA 2000 or by leaving the COG field, 

and sometimes the SOG field too, in the RMC sentence empty. 



 

55 

Some NMEA 0183 repeater displays may not show GPS information if the COG and/or SOG fields are 
empty. When the Suppress Pinning option is enabled, the MiniPlex-3 will fill empty COG and SOG fields 

of an RMC sentence with “0.0” to keep repeater displays happy. 

TAG Blocks 
This option prepends each sentence with a Source TAG block. This TAG block contains a source 

identification parameter, identifying the source of that sentence. Figure 50 shows a few sentences 

prepended with TAG blocks. 

\s:MX63-2*46\$IIGGA,143357.999,5301.0061,N,00635.5479,E,1,06,1.9,90.0,M,,,,0000*2E 
\s:MX63-3*45\$GPGGA,143357.999,5301.0061,N,00635.5479,E,1,06,1.9,90.0,M,,,,0000*39 
\s:MX63-2*46\$IIGLL,5301.0061,N,00635.5479,E,143357.999,A*22 
\s:MX63#1B*09\$HEHDT,67.0,T*1E 

 

 

The TAG blocks in first three lines identify an NMEA 0183 input with one digit after a dash whereas the 

TAG block in last line identifies an NMEA 2000 source with its hexadecimal Source Address after the hash 

sign. 

TAG blocks can be useful if multiple MiniPlex-3E multiplexers are connected to a network. Receiving 

devices/software can decode a TAG block to determine the source of an NMEA 0183 sentence on the 

network. 

MPXConfig3 enables TAG blocks temporarily for the duration of the connection and uses the source 
information for filling the routing table during a Capture or to selectively show NMEA sentences in the 

NMEA viewer 

The MiniPlex-3 Command Reference (available on our website) contains a description of TAG blocks and 

their format. 

Use internal variation table 
The MiniPlex-3 has an internal magnetic variation table which provides a magnetic variation for every 

location on earth, ranging from 88º N to 88º S and 180º E to 180º W. 

If this option is enabled and a GPS location is received from any source, then the MiniPlex-3 will replace 
magnetic variation in NMEA 0183 sentences and NMEA 2000 PGN’s it transmits with a magnetic variation 

from this table. 

These sentences and PGN’s are: HDG (Magnetic Heading), RMC (GPS Position), PGN 127250 (Vessel 

Heading) and PGN 127258 (Magnetic Variation). 

Any conversion between magnetic and true heading (see tab Conversions) will also use this table when 

this option is enabled. 

The magnetic variation table in the MiniPlex-3 firmware will be updated each year and is obtained from 

NOAA, using the WMM model. 

Modbus 
Modbus is a widely used industrial protocol between PLCs (Programmable Logic Controllers) and sensors. 

When this option is set to Master, the MiniPlex-3 can read data from such sensors and convert these 

sensor readings into NMEA 0183 $YXXDR sentences. 

When this option is set to Slave, the MiniPlex-3 will present all common navigation parameters received 

through its NMEA 0183 inputs in a set of Modbus Holding registers. 

When either option is enabled, NMEA Out2 becomes a Modbus RTU (RS485) port to which Modbus 

sensors or a PLC can be connected. 

In Master mode, a Modbus tab will be available containing the Modbus Slave table and controls to 

manage that table. The Modbus feature is described in detail in chapter Modbus on page 74. 

Unique ID 
The Unique ID is a text string which is placed in a Source TAG block. When no Unique ID is entered or the 

existing Unique ID is erased, a default Unique ID is set. The default Unique ID is “MXnn” where nn are 

the last two digits of the serial number of the MiniPlex-3. 

NMEA 0183 Generation from NMEA 2000 and SeaTalk 
This section controls which NMEA 0183 sentences are generated from NMEA 2000 and SeaTalk data. The 

factory default settings are sufficient for most applications. 

Figure 50 
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When connected devices require other sentences, they can be enabled here. For instance, a VHF radio 
might require a GGA sentence for GMDSS, instead of an RMC sentence. Similarly, some autopilots are 

known to require APB and XTE in addition to the RMB sentence to operate properly. 

Option GSx enables both GSA and GSV sentences. 

Option BWx enables either BWC or BWR, depending on PGN 129284, field 6 (Calculation Type). If the 
Calculation Type is Rhumb Line, a BWR sentence is generated. In all other cases (Great Circle or Not 

Available) a BWC sentence is generated. This option also enables the WCV sentence, which contains the 

waypoint closure velocity. 

10 Hz 
This option sets the frequency of the RMC, GGA, GLL and VTG sentence to 10 Hz. This will result in 10 

position updates per second, taking advantage of NMEA 2000 PGN 129025, Position, Rapid Update, which 

is also transmitted at 10 Hz. The COG and SOG values in the RMC and VTG sentences will be updated at 

4Hz, which is the frequency of PGN 129026, COG & SOG, Rapid Update. 

Be careful when routing these sentences to NMEA outputs that operate at a slow speed: A single RMC 

sentence at 10Hz will certainly overflow an output at 4800 Baud! In such a case, create an entry for this 

sentence in the routing table and use the Divisor to reduce the frequency. 

System Time – ZDA/PGN 126992 
This option will enable the output of a ZDA sentence or PGN 126992 containing System Time. The 

MiniPlex-3 features an internal real-time clock which can be set from a time source or be free running. 

This clock will be set when a system time is received from either NMEA 2000, NMEA 0183 or SeaTalk. The 
system time will never be retransmitted on the same bus or protocol it was received from. For example: 

if the System Time was received from an NMEA 0183 RMC or ZDA sentence, the MiniPlex will only 

transmit the System Time on NMEA 2000 and SeaTalk. 

The priority of the System time in case of multiple sources is, in descending order, NMEA 2000 > NMEA 

0183 > SeaTalk. 

Both the Source field (2) in PGN 129992 as the Talker ID of the ZDA sentence transmitted by the 

MiniPlex-3 will indicate the source of the System Time. 

When a System Time is no longer received, the MiniPlex-3 will stop transmitting System Time. 

The ZDA sentence is generated internally, originating from the NMEA Conversions input and transmitted 

by default on the host interfaces only. When it needs to be transmitted from one of the NMEA outputs, 

either the default route from NMEA Conversions to Out1 and/or Out2 must be enabled or 

“--ZDA” must be entered in the routing table, with input C and the desired outputs enabled. 

PGN 126992 is transmitted from the Main device of the MiniPlex-3. 

MDA 
This option enables the deprecated MDA sentence containing meteorological data. 

VBW/VHW (Speed) at 10 Hz 
This option sets the frequency of the VBW and VHW sentences (speed through water) to 10 Hz. 

Attitude 
This drop-down menu selects which NMEA sentences are being transmitted for attitude and heave. The 
default setting is XDR. When PFEC is selected, the MiniPlex-3 will transmit two Furuno Proprietary 

sentences: $PFEC,GPhve containing heave and $PFEC,GPatt containing attitude. These are non-standard 

NMEA sentences and only recognized by specific Furuno navigation equipment. 

Depth 
This drop-down menu selects which NMEA sentence (DPT or DBT) is being transmitted when depth is 

received from an NMEA 2000 or SeaTalk source. The default setting (DPT) is the preferred setting 

because the DPT sentence also contains the transducer offset and the maximum range that can be 

measured. A DBT sentence is sometimes required by older navigation devices. 

True heading 
This drop-down menu selects which NMEA sentence (HDT or THS) is being transmitted when true heading 

is received from an NMEA 2000 source. The Talker ID of the generated sentence depends on the true 
heading source. In case of a GPS compass the Talker ID will be “GP”, “HE” will be used for all other 

sources. 
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Conversions 
The MiniPlex-3 can convert certain NMEA 0183 sentences into new sentences. These can be sentences 

received on inputs 1 to 4 or sentences created from an NMEA 2000 or SeaTalk source. The original 

sentence remains unaffected, a conversion always creates a new additional NMEA 0183 sentence. 

When the address field of the converted sentence is identical with the original sentence, like a reversed 

true heading (HDT → HDT), the converted sentence appears on a virtual input called NMEA Conversions 

(column C in the routing table). When the address field of the converted sentence differs from its original 

then the conversion result appears from the same source as the original. 

This ensures that a conversion result can always be routed separately from the original sentence. 

Note that if the original sentence should be blocked, its entry in the routing table must have a checkbox 

on the input side of the table but no checkbox on the output side. The checkbox on the input side ensures 

the sentence is passed to the conversion function. 

 

Figure 51 

Heading 

Heading Magnetic → True (HDG → HDT) 
This option converts magnetic to true heading and vice versa. If the MiniPlex-3 receives an HDG or HDM 

sentence (magnetic heading), it will generate an HDT sentence (true heading). If the multiplexer receives 

an HDT sentence, it will generate an HDG sentence. 

If the originating HDG sentence contains magnetic variation and/or deviation, these are used to calculate 

a true heading from the magnetic heading. If the originating HDG sentence contains no variation, the 

MiniPlex-3 will use any variation received from an NMEA 0183, NMEA 2000 or SeaTalk source. The 

variation in the HDG sentence always takes precedence over any other variation. 

When converting from HDT to HDG, the MiniPlex-3 will use deviation and variation from any source to 

calculate the magnetic heading. 

If option Use internal variation table on the Options tab is enabled, then the variation from the 

internal variation table will be used for all calculations from magnetic to true heading and vice versa. 

The resulting conversion originates from the same source as its original. 

Reverse Heading (HDM/HDG/HDT/THS) 
This option reverses the heading from any received heading sentence. On reception of a heading 
sentence, the MiniPlex-3 transmits a new heading sentence with 180° added to the original heading. This 

can be used to provide two opposing navigation stations on ferries with a heading from the same source.  

The resulting conversion originates from input NMEA Conversions (column C in the routing table), 

allowing the original and converted sentences to be routed differently. 

The Talker ID in HDT and THS sentences is preserved to ensure compatibility with GPS compasses, which 

generally output a Talker ID “GP”. 
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COG to True Heading (VTG → HDT) 
This option converts a VTG sentence from a GPS into an HDT sentence, using the course over ground to 

simulate a true heading. 

The resulting conversion originates from the same source as its original. 

HDT → THS 
This option converts an HDT sentence into a THS sentence and vice versa. The Talker ID in HDT and THS 

sentences is preserved to ensure compatibility with GPS compasses, which generally output a Talker ID 

“GP”. 

The resulting conversion originates from the same source as its original. 

Speed 

GPS Speed to Log Speed (VTG → VHW) 
This option converts a VTG sentence from a GPS into a VHW sentence, using the speed over ground to 

simulate a speed through water. This option can be useful to simulate a log with a stuck paddlewheel. 

If the MiniPlex-3 receives heading from any source, the heading fields of the resulting VHW sentence will 

be filled. Otherwise, they will be left empty. The COG fields of the originating VTG sentence are not used 

for this conversion. 

The resulting conversion originates from the same source as its original. 

Log Speed to GPS Speed (VHW → VTG) 
This option converts a VHW sentence from a speed log into a VTG sentence, using the speed through 

water to simulate a speed over ground. This can be useful if a device needs a VTG sentence while only a 

Log is available. 

The resulting conversion originates from the same source as its original. 

Reverse Speed (VBW) 
This option reverses/changes the sign of all speed fields in a VBW sentence. 

The resulting conversion originates from input NMEA Conversions (column C in the routing table), 

allowing the original and converted sentences to be routed differently. 

Combine Heading and Speed into VHW 
This option combines magnetic and/or true heading from any source with speed through water from any 

source into a VHW sentence. Where the resulting VHW sentence originates from, depends on the source 
of the speed through water: if the source is a VHW sentence, NMEA 2000 or SeaTalk, then the converted 

VHW sentence originates from input NMEA Conversions. If the source is a VBW sentence, then the 

converted VHW sentence originates from the same input.  

Miscellaneous 

TLL to WPL 
This conversion is useful when marking a target on a target-capable echo sounder. When a target is 

market, such an echo sounder outputs an NMEA TLL sentence. When this conversion is enabled, the 
MiniPlex will convert this TLL sentence into a WPL (Waypoint Latitude and Longitude) sentence. A 

receiving chart plotter will then mark the sounder target on the screen as a waypoint. 

The waypoint name in the WPL sentence will be one of the following: 

• The Target Name field in the originating TLL sentence. 

• TGT-xx where xx is the Target Number (two digits) in the originating TLL sentence if the Target Name 

field is empty. 

• TGT-xxxxx where xxxxx is an incrementing number from 0 to 65535 if the Target Number field is also 

empty. 

After each power-up or reset of the MiniPlex, the xxxxx will start at 0. 

TLL to PGN 130074 
This option will convert a target from a TLL sentence to PGN 130074 (WP Name & Position). It is 

effectively an extension of the TLL to WPL conversion, transmitting the same waypoint on the NMEA 2000 

network. This option can thus only be enabled if TLL to WPL is enabled too. 
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Wind 

VWR → MWV 
This option converts a VWR sentence into an MWV sentence and vice versa. Sometimes software expects 
one sentence while the available wind instrument generates the other. By enabling this option, “old” and 

“new” can be connected without problems. 

The resulting conversion originates from the same source as its original. 

Apparent to True Wind (MWV,R → MWV,T) 
This option converts apparent wind (AWA/AWS) into true wind (TWA/TWS) using the STW from any 

available source of water speed. If required, SOG instead of STW can be used by changing the Speed 

source for True Wind setting to SOG. 

The resulting conversion originates from the same source as its original. 

If only VWR sentences are available, the VWR → MWV option can be enabled to convert these to MWV 

sentences first. 

Calculate Wind Direction (MWV,T → MWD) 
This option converts true wind angle into true wind direction using any magnetic and true heading 
source. If only apparent wind is received, option Apparent to True Wind can be enabled to provide true 

wind. 

The resulting conversion originates from the same source as its original. 

Reverse Wind Angle (MWV) 
This option reverses the wind angle in an MWV sentence. 

The resulting conversion originates from input NMEA Conversions (column C in the routing table), 

allowing the original and converted sentences to be routed differently. 

Speed source for True Wind 
This setting chooses which speed is used to calculate true wind. The default and preferred setting is STW 

(speed through water). Selecting SOG uses speed over ground from a GPS source. 

Datasources for rotating mast wind sensorThe MiniPlex-3 also performs some automatic conversions on 
specific NMEA 0183 sentences. These conversions are corrections of erroneously formatted fields or 

invalid field values. 

VTG 
Some GPS receivers output a COG of 360º when moving north. Other devices may regard this as an 

illegal value. Therefore, the MiniPlex-3 converts every COG of 360º into 0º. 

TTM 
Some radar systems transmit a TTM (Tracked Target Message) sentence with a one-digit Target Number. 
This violates the NMEA 0183 standard, which specifies this field as a two-digit number. As a result, many 

ECDIS systems do not accept such a sentence. The MiniPlex-3 checks the length of this field and adds a 

leading zero when a one-digit Target Number is detected. 

Sentence Rebuilding 
The MiniPlex-3 possesses a very unique feature called Sentence Rebuilding. This feature allows you to 

build a completely new NMEA 0183 sentence using the contents of another sentence. 

Since this requires a complex command with a variable number of fields, there are no user interface 
controls defined for this in MPXConfig3. The Sentence Rebuilding definition must be entered as a 

proprietary sentence in Send NMEA. The starting ‘$’ character may be omitted. 

The format and meaning of the fields of this proprietary sentence is shown below: 

$PSMDSR,a,b,ccccc,ddddd,text,…,text 

a: Sentence Status flag: 

C = sentence is a command to change settings  

R = sentence is a status report of current settings 

b: Definition number (1..3) 

ccccc: Address field of originating sentence. Wildcard characters (‘-’) are accepted, matching on every 

character. 

ddddd: Address field of new sentence 
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text: Arbitrary number of text fields defining the fields of the new sentence. A percent sign followed 

by a number (e.g. “%3” or “%11”) within these text fields is replaced with the contents of that 

field from the originating sentence. All other valid NMEA characters are copied verbatim to the 

new sentence. 

The use of the placeholder “%x” might be best explained using human language. Imagine we have a 

sentence A like below: 

 A: My house is blue 

and we want to build a new sentence B about the colour of our car, using the colour of the house 

mentioned in the sentence A. The Sentence Rebuild definition would then look like this: 

 B: My car is %4 

Now if the MiniPlex-3 receives the sentence A, it will generate sentence B and at the position of “%4” it 

will put the fourth word of the sentence A, resulting in: 

 B: My car is blue 

Translated to NMEA sentences, A is the address field of the originating sentence like GPRMC, and B is the 

address field of the new sentence like GPVTG, while the individual words of a sentence are the parameters 

of an NMEA sentence, separated by commas. 

Example 
Suppose we want to convert an RMC sentence into a VTG sentence. The symbolic format of a VTG 

sentence is shown below: 

$GPVTG,<COG_T>,T,<COG_M>,M,<SOG_N>,N,<SOG_K>,K,A 

<COG_T> is the true course over ground, <COG_M> is the magnetic course over ground and so on. The 

last ‘A’ is the mode field of the VTG sentence. We’re going to take that field from the RMC sentence as 

well. 

The RMC sentences has a SOG in field 7, a true COG in field 8 and a GPS mode in field 12: 

$GPRMC,124026.83,A,5221.62284,N,00505.00865,E,0000.7,088.0,100822,2.5,W,A,S 
   0       1     2     3      4      5      6   7      8      9    10 . 12 

A field from the RMC sentence is copied into the new VTG sentence by referring to this field with “%x” 

where ‘x’ is the field number into the RMC sentence. So, when we place ‘%7’ in a text field of the 

PSMDSR sentence, it is replaced by the contents of field 7 of the RMC sentence. 

To convert GPRMC into GPVTG, the following PSMDSR command is required 

PSMDSR,C,1,GPRMC,GPVTG,%8,T,%8,M,%7,N,,K,%12 

When this command is entered in Send NMEA, the MiniPlex-3 will respond with 

PSMDSR,R,1,GPRMC,GPVTG,%8,T,%8,M,%7,N,,K,%12 

as a confirmation the command is accepted. The ‘1’ in the second parameter field of the PSMDSR 

command tells the MiniPlex-3 to store this as Rebuild Definition number 1. Up to three Rebuild Definitions 

can be stored. 

All the fields from GPVTG onwards are copied as a new sentence, copying all characters verbatim and 

replacing the “%8”, “%7” and “%12” with fields 8, 7 and 12 of the originating GPRMC sentence. The ‘$’ 

character preceding the address field of the VTG sentence is added automatically. 

The resulting VTG sentence will appear as: 

$GPVTG,088.0,T,088.0,M,0000.7,N,,K,D 

The SOG field preceding the ‘K’ is left empty, simply because there is no SOG in km/h present in the RMC 

sentence, so we left this empty in the Sentence Rebuilding definition. 

Command PSMDSR requests all stored Sentence Rebuilding definitions. To erase a single definition, 

execute PSMDSR,C,x where x is the definition number 1, 2 or 3. 
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Routing 
The routing table is the most powerful feature of the MiniPlex-3. It allows NMEA 0183 sentences to be 

filtered and routed based on their Address Field and source, and optionally reduce their rate or frequency 

when routed to one of the NMEA 0183 outputs. 

The routing table stores up to 50 entries, either entered manually or by capturing the NMEA 0183 

sentences received/generated by the multiplexer. 

 

Figure 52: Routing table on an NMEA 0183-only MiniPlex-3 

 

NMEA 2000 and SeaTalk data is also routed here, though not based on their PGN or datagram number 

but by the equivalent NMEA 0183 sentence they are converted to. 

 

Figure 53: Routing table on an NMEA 2000 enabled MiniPlex-3 

 

Each entry in the routing table contains the Address Field of an NMEA sentence, checkboxes to specify its 

source and destination and a divisor factor to reduce the sentence rate or frequency. 
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Routing Table Columns 
The routing table contains the following columns: 

Index: The leftmost column is the entry number. Clicking on a number enables the Delete button to 

delete the entry. 

Inputs: 

 1-4: NMEA 0183 inputs 1 to 4. If In 1 is set to SeaTalk, the “1” changes into “ST” 

 C: NMEA 0183 Conversion results 

 H: Input from the Host port(s) 

 N: Input from the NMEA 2000 port1 

Device: Source device of the NMEA 2000 data1 

Sentence: The Address Field of an NMEA 0183 sentence. This fully specifies the type of NMEA sentence 

to be filtered or routed. A “–” (dash) matches any character in the Address Field. For 
instance, if an entry contains “––GLL”, any sentence that ends on GLL will match, regardless 

of its Talker ID (the first two characters). Similarly, a “P––––” will match on every 

proprietary sentence starting with $P. 

The Sentence field must contain 5 characters. 

Div: Divisor field. A number from 1 to 99 will divide the sentence rate or frequency by the number 

entered. If this field contains a divisor of 5 for instance, every fifth occurrence of this 

sentence will be passed. The divisor is not applied to the host outputs and to SeaTalk4. Also, 

the divisor can be disabled for NMEA Out 2 

Outputs: 

 1,2: NMEA outputs 1 and 2 

 ST: Output to SeaTalk port2 

 PC: Output to Host port (USB or Ethernet) 

 W: Output to WiFi interface3 

Note 1: This column is only visible when connected to an NMEA 2000 enabled MiniPlex-3. 

Note 2: This column is only enabled if In1 is set to SeaTalk mode. 

Note 3:  This column is only enabled when connected to a WiFi enabled MiniPlex-3. 

Note 4: SeaTalk data is transmitted using fixed time slots, independent of the rate of the originating data received on 

NMEA 0183 or NMEA 2000. The Divisor has no influence on this. 

There is no output column for NMEA 2000. All received NMEA 0183 and SeaTalk data is always 

converted and routed to the NMEA 2000 network. 

Table Buttons and Controls 
The following controls are available to edit the table: 

Capture: Enables capture mode. The table will be filled automatically with NMEA 0183 sentences 

currently received by the MiniPlex-3. 

Add: Add a new empty entry at the end of the table. 

Delete: Delete an entry from the table in MPXConfig3. Click on the Index number of the entry to be 

deleted. This will enable the Delete button. 

Clear: This button clears the table in MPXConfig3 (not in the MiniPlex-3!). To clear the table in the 

MiniPlex-3, click on the Store button after clearing the table in MPXConfig3. 

Store: Stores the table from MPXConfig3 into the MiniPlex-3. This overwrites the table inside the 

MiniPlex-3. 

No Match: This setting determines what happens if a received sentence is not found in the routing 

table. Set to Default to apply the default route or Block to block the sentence. 
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Editing the table 
It is important to keep in mind that all modifications and additions are made to the routing table in 

MPXConfig3 only. The current table is automatically loaded from the MiniPlex-3 to MPXConfig3 when you 

connect to the MiniPlex-3 or when you click on the Read Configuration button. After editing, the table 

must be stored in the MiniPlex-3 using the Store button to be effective. 

Inputs/Outputs: Clicking on a checkbox in an Inputs or Outputs column enables a sentence from 

that input or to that output. 

Device: The Device field can be filled by double-clicking on the field and selecting the desired 
NMEA 2000 device from the window that appears. The Device field can be cleared 

again by selecting it and pressing the Delete key on your keyboard. 

Sentence/Div: The Sentence and Divisor fields can be edited by selecting it with the cursor. Edit 

mode is entered in several ways: 

● Press function key F2 on your keyboard. This enters Edit mode with the cursor at 

the end of the text. Move the cursor around with the mouse or arrow keys. 

● Press Enter or click with the cursor: This enters Edit mode with the text selected 

and the cursor at the first character. Any character or number that is typed now 
will erase the existing text entirely unless the cursor is moved around with the 

mouse or arrow keys. This will unselect the text. 

When changes are made, press Enter to confirm them or press Escape to discard any changes and exit 

Edit mode. 

Note on editing tables 
All tables in MPXConfig3 (Routing, AIS MOB and Modbus) operate in the same way. The buttons Add, 

Delete, Clear and Store on these tabs operate in the same way, as well as editing text fields. 

Filling the table 
The routing table can be filled in two ways: Use the Add button to add entries to the table or the 

Capture button to fill the table with sentences currently being received. When using Capture, ensure 

the routing table inside the MiniPlex-3 is cleared first by clicking on Clear and Store. Otherwise, you 

would be capturing data which is already routed or filtered. 

All controls will be disabled during capture and the Capture button changes to Stop. Leave the capture 

mode running for approximately 10 seconds. By that time, all connected devices will have transmitted 

NMEA sentences, which are now stored in the routing table in MPXConfig3. Click on Stop to end the 

capture mode. 

The captured entries will have checkboxes in the input columns, indicating the source of each entry. 

It is absolutely necessary to review and modify the routing settings for each sentence after a 

Capture. Use the routing table with care! Simply capturing the table and storing it unmodified 

is useless and can lead to unforeseen problems! 

The general advice is to remove entries from single sources that should be routed to a host only. The 

Default Route already takes case of these sentences. The two main reasons for using the routing table 

are: 

1. Route specific sentences to an NMEA 0183 output 

2. Block duplicate sentences 

The Technical Reference lists commonly used Talker ID’s and Sentence Formatters. These lists can be 

a useful aid while setting up the routing table as they explain the nature of the sentences and which 

information they contain. 

It is very important to realize that using a capture to fill the table overrides the default routes since every 

sentence is in the routing table. 
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NMEA 2000 Sources 
A checkbox in the N column and an empty Device field will pass that sentence from every device on the 

NMEA 2000 network. Using only the checkbox is sufficient in case of a single source of each sentence. 

When multiple sources of the same sentence exist, use the Device field to select the source of that 
sentence. To add a device, double-click on the Device field of the desired routing entry. This will open a 

window showing all devices on the NMEA 2000 network: 

 

Figure 54 

Double-click on the desired entry or select it and click on the OK button to save the device into the 
routing table. Clicking the Cancel button leaves the routing table untouched. The Refresh button 

performs a re-scan of all devices on the NMEA 2000 network. The latter would only be required if a 

message appears that new NMEA 2000 devices have been detected. 

Routing Operation 
When the MiniPlex-3 receives an NMEA 0183 sentence or creates one from an NMEA 2000 or SeaTalk 

source, it searches the routing table for a match in the order as the entries appear in the table in 

MPXConfig3. 

If a match is found (address field and input/source match), the sentence is accepted for further 

processing and routing. If only the address field matches, the search continues until a full match is found 

or the end of the table is reached.  

If no match is found, the No Match setting determines what happens next: when set to Default, the 

default route is applied. When it is set to Block, the sentence is blocked. 

The default routes are set in section Input Settings on the NMEA Inputs/Outputs tab. 

Note that the MiniPlex-3 will not pass any sentence if the routing table is empty, and the No Match 

setting is set to Block. 

Received NMEA 0183 sentences are following a specific processing route, as shown in Figure 55 below: 

 

Figure 55 

A few important things can be seen from this figure: 

• The GPS Status check blocks a GPS related sentence at this point if its status flags are set to 
“invalid” in case of no GPS fix. This will trigger the Priority block further up in the chain to pass a 

lower priority source. 

• If a Talker ID is set for an input, it is applied to received NMEA sentences before filtering is 

applied. A routing entry must therefore contain the correct Talker ID. 
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• Conversions are applied after filtering. As a result, sentences that are blocked on an input will not 
be converted. This implies that if a sentence must be converted and only the conversion result is 

required, the originating sentence must be enabled on the receiving input and blocked on all 

outputs. The conversion result needs to be enabled on the C input and routed to the desired 

output. 

Example 
Figure 56 shows a small routing table: 

 

Figure 56 

These entries have the following effect: 

1. GPRMC sentences received from SeaTalk are routed to output 1. 

2. HEHDT sentences received from input 2 are routed to SeaTalk, the PC and WiFi. Only every 5th 

sentence is passed to Out2. 

3. WIMWV sentences received from any NMEA 2000 source are routed to the PC and WiFi. 

4. WIMTW sentences received from any NMEA 2000 source are routed to the PC and WiFi. 

5. VWVHW sentences received from SeaTalk are routed to the PC and WiFi. 

6. AIVDM sentences received from any NMEA 2000 source are routed to Out2 and WiFi. 

7. GPRMC sentences received from the HDS Gen2 5m iGPS are routed to the PC and WiFi. 

8. GPRMB sentences received from the HDS Gen2 5m Navigator are routed to SeaTalk. 

Note that entries 7 and 8 apply to the same Lowrance HDS Gen2 5m chart plotter. Most chart plotters 
present multiple virtual devices on the NMEA 2000 network, as can be seen in the NMEA 2000 Devices 

window in Figure 54. In this case, one device is the GPS, and the other device is the Navigator - the 

source that transmits PGNs used for controlling an autopilot. 

  



 

66 

NMEA 2000 
In general, it is not necessary to change any of the settings on this tab. If all devices on the NMEA 2000 

network receive the converted NMEA 0183 from the MiniPlex-3, everything is just fine. 

The MiniPlex-3 announces itself on an NMEA 2000 as six virtual devices: one Main device, and one device 

for each NMEA 0183/SeaTalk input and the conversion results. Each device has its own Device Type, 

Source Address and Device Instance. 

Source Addresses are allocated automatically during the Address Claim Procedure each device performs 

during start-up, or if an address contention occurs when another device claims the same Source Address. 

The Address Claim Procedure ensures that each device on the NMEA 2000 has a unique Source Address. 

This unique Source Address, which is attached to every message transmitted onto the NMEA 2000 

network, ensures that receiving devices can distinguish similar data from different devices. The Source 

Address is key for a working data source selection. 

 

Figure 57 

Device Settings 
The settings in this section control how each virtual device of the MiniPlex-3 is identified on the NMEA 

2000 network. 

Device Type 
Each device on an NMEA 2000 network has a Device Class and Device Function code, identifying the 

device type to other devices on the network. These codes are contained in the Address Claim Message 

(PGN 60928) each device transmits on start-up and on request of other devices. These codes enable 

other devices to make an automatic “best choice” for a data source. 

In MPXConfig3, a Device Type can be selected for the Main device and each of the NMEA 0183 inputs. 

Selecting a Device Type sets the right Device Class and Device Function code for each virtual MiniPlex-3 

device. In general, it is not necessary to change any of the settings on this tab; the default Device Types 

are fine in most situations. 

In some cases, however, it might be convenient (1) or even required (2, 3) to set a Device Type that 

matches with the device connected to the NMEA 0183 input: 

1. An AIS transponder and a GPS are connected to two NMEA 0183 inputs of the MiniPlex-3 and a 

plotter is connected to the NMEA 2000 network. This plotter will see two similar sources of GPS data, 
both originating from an NMEA 0183 Gateway. The plotter will randomly decide which source to 

use. 

By setting the AIS input to AIS and the GPS input to Ownship Position (GNSS), that same plotter 

could make an “educated” decision to use the GPS as data source for position data and fall back to 

the AIS in case the GPS fails. 

2. A GPS is connected to an NMEA 0183 input of the MiniPlex-3 and a GMDSS capable VHF radio is 

connected to the NMEA 2000 network. Some radios are known to only accept position data from a 

GPS device for safety reasons. They do not accept position data from any other source such as an 
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NMEA 0183 gateway. In this case, it is necessary to set the Device Type of the NMEA 0183 input of 

the MiniPlex-3 to Ownship Position (GNSS). 

3. In case of device type Weather Instrument (< V2), the MiniPlex-3 will transmit PGN’s 130310, 

130311 and 130312 instead of PGN’s 130313, 130314 and 130316. This can be required if other 

devices only support NMEA 2000 V1.200 messages. 

Some Device Types are marked with “(< V2)”. In the transition from V1.300 to V2.000 of the NMEA 2000 

standard, some Device Class and Device Function codes were changed. Older devices supporting NMEA 

2000 V1.300 and older may therefore not recognize V2.000 Device Class and Device Function codes. The 

“(< V2)” Device Types can then be used to ensure backwards-compatibility with older NMEA 2000 

devices. 

When an NMEA input of the MiniPlex-3 is set to a “(< V2)” device, the Product Information PGN 

transmitted for this input will report an “NMEA Message Database Version” of 1.300. 

SA - Source Address 
This column shows the Source Address claimed by each virtual MiniPlex-3 device. This Source Address 

identifies the NMEA 2000 data each input transmits on the NMEA 2000 network. 

Other devices on the NMEA 2000 network use these addresses to specifically select a MiniPlex-3 
input/virtual device as data source. These Source Addresses listed are allocated automatically on start-up 

of the MiniPlex-3 and/or the NMEA 2000 network. 

A “n/a” at any of the inputs indicates that the input couldn’t claim a Source Address and it will not 

transmit any data on the NMEA 2000 network. To resolve this, enter command PSMDRESET in Send 

NMEA to reset the MiniPlex-3. This will start the Address Claim Procedure and after a moment all inputs 
should have claimed a Source Address. If “n/a” still shows up, there is a problem on the NMEA 2000 

network. 

Setting a Source Address 

There is one case in which setting a Source Address is required: On a Raymarine SeaTalkNG network, 
Source Addresses are used to determine the priority of a data source: a higher Source Address implies a 

higher priority of the data source. 

When a fast or high precision heading sensor with an NMEA 0183 output is connected to a SeaTalkNG 

network through a MiniPlex-3 (or any other NMEA 0183/2000 gateway), A Raymarine autopilot system 
will generally ignore this heading source and use the heading source of the autopilot system instead. By 

setting the Source Address of the MiniPlex-3 input that receives this heading to a high value like 200, the 

Raymarine autopilot will accept the heading from the MiniPlex-3. The highest Source Address that can be 

entered, is 251. 

There is no guarantee that a given Source Address is also obtained. If the MiniPlex-3 tries to claim a 

given Source Address, another device on the network may already have claimed this Source Address. If 

this is the case, the numerical value (NAME) in the Address Claim message that both devices will transmit 

on the NMEA 2000 network determines who “wins” this address. The device losing this claim must then 
claim a new Source Address. If the MiniPlex-3 wins, the entered Source Address will remain the same, 

otherwise a different value may appear. The NMEA 2000 Device List (Figure 58) can be used as a guide 

to find a free or unused Source Address.  

DI - Device Instance 
Every device on an NMEA 2000 network has a Device Instance: a number with a valid range from 0 to 

255, providing a means to enumerate the number of like devices (same Class and Function codes) on the 

NMEA 2000 network. 

The DI of each NMEA 0183 input can be set to provide this enumeration. For instance, if two depth 

sensors are connected to two NMEA 0183 inputs of the MiniPlex-3, assigning different DIs to each input 

allows other devices to enumerate both depth sensors. 

The NMEA 2000 numbering convention is to start from 0, incrementing from port side of the vessel to 

starboard, then from bow to stern. 

The default Device Instance value is 0 and it is not necessary to change it if no NMEA 0183 input receives 

the same data.  

Generate $MXPGN 
The options in this section control if and when $MXPGN sentences are generated by the MiniPlex-3. These 

sentences contain the PGN number, an attribute field and the binary data of the PGN, all represented as 

hexadecimal ASCII numbers: 

$MXPGN,01F112,2807,FC7FFF7FFF168012*11 

See the Technical Reference section for a description of the $MXPGN sentence and how it can be used. 
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From unknown PGNs 
Unknown PGNs are PGNs which are not converted to NMEA 0183 sentences. When this option is enabled, 

only unknown PGNs are converted into $MXPGN sentences. 

This option can be useful when navigation software needs to read PGNs for which no equivalent NMEA 

0183 sentence exists. Such PGNs could contain an electrical switch position or proprietary data. 

Converting these PGNs to $MXPGN sentences allows developers to easily read NMEA 2000 data using 

existing NMEA 0183 sentence parsing code. 

From all PGNs 

When this option is enabled, the conversion from NMEA 2000 PGNs to NMEA 0183 sentences is 

completely disabled and every received NMEA 2000 PGN is converted into one or more $MXPGN sentences. 

This allows software on a PC to read and decode every possible NMEA 2000 PGN. 

It is also possible to send an $MXPGN sentence to the MiniPlex-3 using an NMEA 0183 input or host 

interface. The MiniPlex-3 will then convert this to an NMEA 2000 PGN and transmit it onto the NMEA 2000 

network, provided the Write bit in the attribute field of the $MXPGN sentence is set to ‘1’. 

When support is requested, we often ask you to enable this option prior to generating an NMEA log file. 

This allows us to “replay” your NMEA 2000 data onto the NMEA 2000 network in our office, to duplicate 

the problems you encounter. 

Device List 
This button opens a window showing all devices that are present on the NMEA 2000 network. 

 

Figure 58 

The most important information of each device on the NMEA 2000 network is listed. More detailed 

information can be obtained by double-clicking on a device entry. This will open a window as shown in 

Figure 59. 



 

69 

 

Figure 59 

This window shows all available information of a device. The Device Instance and System Instance of a 

device can be changed to suit the needs of your NMEA 2000 network. In most situations, these settings 

can be left as they are. 

Source Address 
The Source Address is allocated dynamically by each device on the NMEA 2000 network and is shown for 

informational purposes only. 

There is one case in which setting a Source Address is required: On a Raymarine SeaTalkNG network, 

Source Addresses are used to determine the priority of a data source: a higher Source Address implies a 

higher priority of the data source. 

When a fast or high precision heading sensor with an NMEA 0183 output is connected to a SeaTalkNG 

network through a MiniPlex-3 (or any other NMEA 0183/2000 gateway), A Raymarine autopilot system 

will generally ignore this heading source and use the heading source of the autopilot system instead. By 
setting the Source Address of the MiniPlex-3 input that receives this heading to a high value – such as 

200 – the Raymarine autopilot will accept the heading from the MiniPlex-3. The highest Source Address 

that can be entered, is 251. 

There is no guarantee that a given Source Address is also obtained. If the MiniPlex-3 tries to claim a 
given Source Address, another device on the network may already have claimed this Source Address. If 

this is the case, the numerical value (NAME) in the Address Claim message that both devices will transmit 

on the NMEA 2000 network determines who “wins” this address. The device losing this claim must then 

claim a new Source Address. If the MiniPlex-3 wins, the entered Source Address will remain the same, 
otherwise a different value may appear. The NMEA 2000 Device List (Figure 58) can be used as a guide 

to find a free or unused Source Address. 

Device Instance 

The Device Instance is a number with a valid range of 0 to 255, providing a means to enumerate the 

number of like devices (same Class and Function codes) on the NMEA 2000 network. 

The Device Instance of each device can be set to provide this enumeration. For instance, if two depth 

sensors are connected to the NMEA 2000 network, assigning different Device Instances to each sensor 

allows other devices to enumerate both depth sensors. 

The NMEA 2000 numbering convention is to start from 0, incrementing from port side of the vessel to 

starboard, then from bow to stern. 

The MiniPlex-3 can use the Device Instance to determine the priority of a Data Source when the Priority 

setting of the NMEA 2000 interface is set to DI on the NMEA Inputs/Outputs tab. A lower value of the 
Device Instance has a higher priority. A value of 0 excludes a Data Source from the priority evaluation. 

The value of the Device Instance is compared one-on-one to the set priority of an NMEA 0183 input. See 

chapter Priority for detailed information about the priority feature of the MiniPlex-3. 

Note: Some SeaTalkNG devices have a fixed, non-zero Device Instance value which cannot be changed. 
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System Instance 
The System Instance is a number with a valid range of 0 to 15 that indicates the occurrence of devices in 

additional network segments, redundant or parallel networks or sub-networks. Devices behind a bridge or 

gateway could be assigned a different (other than 0) Device Instance to indicate that they are on a 

different network segment. This can be used when multiple NMEA 2000 backbones are installed on larger 
vessels or in case of a redundant installation while a bridge connects these networks. Thus, an NMEA 

2000 device on one network segment knows if another device is on the same network segment or on a 

redundant or other segment. For single/small networks, the System Instance should be left at 0. 
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AIS MOB Alarm 
The MiniPlex-3 AIS MOB alarm responds to “AIS SART” messages from AIS-based SART, MOB and EPIRB 

devices. To receive these AIS-SART messages, an AIS transponder or receiver must be connected to the 

MiniPlex-3, either via NMEA 0183 or NMEA 2000. 

The AIS MOB alarm will only trigger on devices listed in the table. Up to eight MMSIs of SART devices can 

be stored in the MiniPlex-3.  

The Switch A and B terminals provide a floating switch contact which closes upon alarm. This contact 

can switch loads up to 60V and 0.5A. 

NMEA Input 4 serves as an Acknowledge/Control switch input. It accepts a 5 – 15V pulse, provided by a 

push-button type of switch. 

Checking the AIS MOB Alarm on the Options tab in MPXConfig3 enables the AIS MOB Alarm tab as 

shown below: 

 

Figure 60 

On this tab, up to eight MMSIs of MOB units can be entered. 

AIS MOB Table Columns 
The AIS MOB table contains the following columns: 

Index: The leftmost column is the entry number. Clicking on a number enables the Delete button to 

delete the entry. 

MMSI: The MMSI number of an AIS MOB device that the MiniPlex-3 should respond to. The MMSI 

entered must contain all 9 digits. 

AL: Alarm field. This field will turn red when an AIS MOB alarm has been received. 

If the AIS MOB alarm is enabled, NMEA Input 4 serves as an Acknowledge/Control switch input and all 

the usual controls for In4 will be invisible: 

 

Figure 61 
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Connections 
To be able to use the AIS MOB Alarm, the following connections need to be made (see Figure 62): 

• A momentary push-button connected to a 12/24V source and NMEA Input 4 

• A buzzer connected to the Switch A/B contacts and 12/24V 

Note that the Switch A/B contacts are rated at 60V/0.6A max, for resistive loads only. The switch is not 

fused and will be destroyed if the rated voltage or current is exceeded. 

A relay can be driven if a flyback-diode is connected in reverse polarity across the coil of the relay.  

 

 
Figure 62: AIS MOB Alarm connections 

AIS MOB Alarm Operation 
When an AIS MOB device is activated, it will transmit AIS-SART messages every minute. When the 
MiniPlex-3 receives these messages from a known device (its MMSI is stored in the MiniPlex-3), the alarm 

sounds indefinitely until the Acknowledge/Control switch is pressed momentarily. Reception of new AIS-

SART messages from another known device will sound the alarm again until pressing the switch. 

When the AIS SART device is recovered and switched off, the MiniPlex-3 will automatically “arm” its MMSI 

for a new alarm after 90 seconds.  

When the Test button of a known SART device is pressed, the alarm will sound for 2 seconds once the 

SART device starts transmitting. This will also arm its MMSI immediately instead of 90 seconds after 

being recovered and switched off. 

Note that a SART device must acquire a GPS fix first, before it will start transmitting in test mode. With 

clear satellite visibility, this should take no more than one minute. 

Learning Mode 
MMSIs can also be added in the Learning Mode, without using MPXConfig3. To enter Learning Mode, 

press and hold the Acknowledge/Control switch for more than 5 seconds. The alarm will sound for 2 

seconds indicating Learning Mode is started. The MiniPlex-3 remains in Learning Mode for 10 seconds. 

Now press the Test button of the SART device which should be added to the list. The MiniPlex-3 will 
confirm reception of the SART-Test message with a short beep of 0.5 second. This will also restart the 10 

second time window of the Learning Mode. Note that the SART device must acquire a GPS fix first, before 
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it will start transmitting. With clear satellite visibility, this should take no more than one minute. A GPS 
fix will most likely be indicated by a LED changing state. In this case, wait for the GPS fix to occur, then 

press and hold the Acknowledge/Control switch to enable Learning Mode on the MiniPlex. 

Up to eight SART devices can be added. When ready adding devices, the MiniPlex-3 will automatically exit 

Learning Mode 10 seconds after the last SART device has been added or when the maximum of eight 

devices has been reached. The alarm will sound for 2 seconds to indicate the end of the Learning Mode. 

A SART device can only be added to the list once. So, if the MiniPlex-3 does not sound in response to 

pressing the Test button on the SART while in Learning Mode, the SART device was already added 

previously. 
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Modbus 
Modbus is an industrial protocol, used to read data from multiple (industrial) sensors on a single RS485 

network. Modbus enabled sensors typically measure non-navigation-related physical quantities like 

temperature, pressure, level or flow. 

When Modbus is enabled, the MiniPlex-3 becomes a Modbus master, utilizing the Modbus-RTU protocol 

via port NMEA Out2. Received sensor data is converted into NMEA 0183 $YXXDR sentences. The 

MiniPlex-3 will group as many sensor values as possible into one XDR sentence as the maximum 
sentence length or 82 characters permits. The exact number of sensor values depends on the chosen 

precision and length of Transducer IDs entered for each slave entry. 

Up to 30 slave definitions can be entered in the table on the Modbus tab. Each entry defines one slave 

address and one register number, along with other parameters regarding the register and data type and 

the required parameters for the XDR sentence. 

 

Figure 63 

Modbus Table Columns 
The Modbus table contains the following columns: 

Index: The leftmost column is the entry number. Clicking on a number enables the Delete 

button to delete the entry. 

Slv: The Modbus slave address of the sensor to be read. Valid addresses are 1 to 247. 

Reg: The Modbus register number of the sensor to be read. The MiniPlex-3 uses 0-based 

protocol addresses, ranging from 0 to 65535. 

T: Modbus Register type: 

 H: Holding register (function code 03) 

 I: Input register (function code 04) 

D: Data type: 

 I: Signed integer (16-bit/1 register) 

 U: Unsigned integer (16-bit/1 register) 
 L: Signed long integer (32-bit/2 registers) 

 F: Floating point (32-bit/2 registers) 

R: Reverse register order in case of a multi-register read operation (Data types “L” and 

“F”). 

P: Precision or number of decimals for value in Modbus register (0 to 7). 

T: Transducer Type character in the generated XDR sentence. 

Transducer ID: Transducer ID in the generated XDR sentence, maximum 15 characters. 

U: Units character in the generated XDR sentence. 

Status: Modbus slave status. 
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Modbus Slave Addresses 
The MiniPlex-3 uses Modbus protocol addresses (0-based) and a specified register type, as opposed to 

PLC addresses (1-based), where the register type is implied by the register number. 

The Holding register range from 0 to 9998 corresponds with a PLC address range from 40001 to 49999 
whereas the Input register range from 0 to 9998 corresponds with a PLC address range from 30001 to 

39999. 

Register Order 
The Reverse option swaps the Modbus registers when a signed long or a float number is read. These 32-

bit numbers are stored in two consecutive 16-bit Modbus registers. 

The Modbus protocol does not specify a 32-bit data size, so the implementation is left to the device 

manufacturers. 

Usually, 32-bit numbers are stored as Big-endian, where the first register holds the most significant 16 
bits and the second register holds the least significant 16 bits. This is in accordance with the Modbus 

protocol, where 16-bit register values are placed in a Modbus frame as two bytes (octets) in Big-endian 

order as well. 

Some devices however store 32-bit numbers in Little-endian order, where the first register holds the least 
significant 16 bits and the second register hold the most significant 16 bits. The Reverse option will swap 

these registers in the response frame of the slave. 

Precision 
The Precision sets the number of decimal places for the specified Modbus register and the resulting data 

field in the XDR sentence. If this field contains 2 for instance, a Modbus register value of 12345 will be 

represented as 123.45 in the generated XDR sentence. 

Slave Status 
The Status column in the Modbus table indicates the status of a Modbus slave. The colour of the field 

indicates the severity of the status. The table below lists all possible indications: 

? Status unknown, slave has not been polled 

yet OK Slave is OK 

E xx Modbus exception xx returned by the slave 

SIZE Slave response has incorrect register count 

WSLV Response from wrong slave received 

COM Communication error (parity, framing or 

overrun) SIZE Slave response has an incorrect frame size 

CRC Slave response has a CRC error 

NRSP Slave does not respond 

 

The Modbus exception codes are defined in the “Modbus Application Protocol Specification”, which can be 

found on www.modbus.org. 

The Status column is not updated “live”, it only updates when you click the Read Configuration button. 

Communication Parameters 
The Modbus RTU protocol on the MiniPlex-3 utilizes 8 data bits, no parity and 2 stop bits. The baud rate 

can be set with the Speed control for NMEA Out2 on the NMEA Inputs/Outputs tab. 

Diagnostics 
In case of communication problems, checking Enable Diagnostics will result in $PSMDMB,D,… and 

$PSMDMB,E,… sentences containing raw Modbus frame data end error reports respectively. The format of 

these sentences can be found in the MiniPlex-3 Command Reference, available on our website. 

  

http://www.modbus.org/
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Firmware Update 
Firmware updates with new features or bug fixes will be available through our web site. These firmware 

files can be downloaded to your computer and loaded into the MiniPlex-3 using menu File > Update 

MiniPlex Firmware. 

MPXConfig3 also contains MiniPlex firmware, which is embedded in the application. This firmware is the 

minimum required version that is compatible with this version of MPXConfig3. 

When MPXConfig3 connects to the MiniPlex, it will interrogate the currently loaded firmware version and 

check that against the minimum version required. If the version in the MiniPlex is lower, an update is 

automatically started. This update can also be forced using menu Tools > Automatic Update. 

Firmware files always contain a complete firmware version, containing all updates from the previous 

versions. 

Procedure 
Make sure the MiniPlex-3 is connected to your computer via USB or Ethernet, start MPXConfig3 and 

connect to the MiniPlex-3. 

In case of a MiniPlex-3E, ensure the MiniPlex-3E is set to TCP first. It is not possible to update the 

firmware using the UDP protocol. 

In case of a MiniPlex-3Wi, connect via the USB interface. It is not possible to update the MiniPlex 

firmware via WiFi. 

Download the firmware update from our web site and unpack the .zip file. Remember in which folder you 

stored the .mpx file. 

Choose menu File > Update MiniPlex Firmware. 

Using the file dialog, locate and select the firmware image file. When you have selected the firmware file 

and clicked on OK, the update process starts. The image file’s integrity and version are checked first 

before initiating the download procedure in the MiniPlex-3. 

When the download starts, the red LED on the MiniPlex-3 will be lit continuously while the green LED 

blinks on reception of firmware data. MPXConfig3 will show a progress indicator during the update 

process. When the update is complete and successful, a message will show “The firmware update was 

successful”. 

Any errors that occur during the process will be shown. It is important to make a note of the error 

message when asking for support. See Firmware Update Error messages for an explanation of the 

error messages. 

Whenever the update process fails, the MiniPlex-3 will start transmitting $PSMDLDR… sentences. This 

indicates that no firmware is loaded and that the MiniPlex-3 is waiting for a new firmware update. Just try 

updating again until the process is successfully finished. 

Sometimes the communication during the firmware update times out and the update is aborted with an 
error message. This time out can be caused by delays in the communication drivers that are part of 

Windows. These time outs can happen when other software is communicating with other serial devices at 

the same time. 

When such a time out occurs, the MiniPlex-3 has no firmware loaded and it keeps transmitting $PSMDLDR… 

sentences, indicating that it is waiting for firmware. Just try updating again until the process is 

successful. Sometimes it helps to try the update on a different computer. 
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Mounting 
The MiniPlex-3 is not waterproof. It should be mounted at a dry place such as behind the instrument 

panel on a flat surface. 

Make sure there is enough space around the MiniPlex-3 to connect the NMEA 0183 wiring at the bottom, 

the NMEA 2000 connector on the left side and USB/Network connector on the right side of the housing. 

 

 

Figure 64: Dimensions 
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Technical Reference 

NMEA 0183 Sentences 

Standard Sentences 
NMEA 0183 sentences always start with a so-called Address Field. This address field determines the 

source and contents of a sentence. The address field itself is split up in two parts: the first two characters 

are the Talker ID and the last three characters are the Sentence Formatter. 

The Talker ID determines the type of device that transmits the sentence, such as “HC” for a magnetic 

compass and “GP” for a GPS. 

The Sentence Formatter determines the contents of the sentence and its format of the data fields, such 

as HDG for magnetic heading or GLL for geographic latitude and longitude. 

Proprietary Sentences 
Proprietary sentences are not defined in the NMEA 0183 standard and always start with a ‘P’, followed by 
a three-character Manufacturer Mnemonic, which is defined by NMEA. Everything after the manufacturer 

mnemonic is defined by the manufacturer. All configuration sentences used by the MiniPlex-3 therefore 

start with $PSMD, where SMD is the manufacturer mnemonic of ShipModul. 

Glossary 
This glossary lists the most common Talker ID’s and Sentence Formatters in alphabetical order. 

Talker ID’s 
AG Autopilot (general) 

AP Autopilot (magnetic) 

AI Automatic Identification System 

CD Communications: Digital Selective Calling (DSC) 
CR  Data receiver 

CS  Satellite 

CT  Radio telephone (MF/HF) 

CV  Radio telephone (VHF) 
CX  Scanning receiver 

DE Decca navigator 

DF Direction finder 

EC Electronic chart systems (ECS) 
EI Electronic chart display and information system (ECDIS) 

EP Emergency position indicating radio beacon (EPIRB) 

ER Engine room monitoring systems 

GP Global Positioning System (GPS) 
GL GLONASS receiver 

GN Global navigation satellite system (GNSS) 

HC Heading sensors: compass, magnetic 

HE  gyro, north seeking 
HN  gyro, non-north seeking 

II Integrated instrumentation 

IN Integrated navigation 

LC Loran, Loran-C 
MX Multiplexer 

P Proprietary sentence 

RA Radar and/or radar plotting 

SD Sounder, depth 

SN Electronic positioning system, other/general 
SS Sounder, scanning 

TI Turn rate indicator 

VD Velocity sensors: Doppler, other/general 

VM  speed log, water, magnetic 
VW  speed log, water, mechanical 

VR Voyage data recorder 

YX Transducer 

ZA Timekeepers: atomic clock 
ZC  chronometer 

ZQ  quartz 
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ZV  radio updated 

WI Weather instruments 

Sentence formatters 
AAM Waypoint arrival alarm 
ACK Acknowledgement alarm 

ALM GPS almanac data 

ALR Set alarm state 

APB Heading/track controller (Autopilot) sentence B 
BEC Bearing and distance to waypoint, dead reckoning 

BOD Bearing, origin to destination 

BWC Bearing and distance to waypoint 

BWR Bearing and distance to waypoint, rhumb line 
BWW Bearing, waypoint to waypoint 

DBT Depth below transducer 

DCN DECCA position 

DPT Depth 
DSC Digital selective calling information 

DSE Expanded digital selective calling 

DSI DSC transponder initialise 

DSR DSC transponder response 
DTM Datum reference 

FSI Frequency set information 

GBS GNSS Satellite fault detection 

GGA Global positioning system fix data 
GLC Geographic position, LORAN-C 

GLL Geographic position, latitude/longitude 

GNS GNSS fix data 

GRS GNSS range residuals 
GSA GNSS DOP and active satellites 

GST GNSS pseudo range error statistics 

GSV GNSS satellites in view 

HDG Heading, deviation and variation 
HDT Heading, true 

HMR Heading monitor – receive 

HMS Heading monitor – set 

HSC Heading steering command 
HTC Heading/track control command 

HTD Heading/track control data 

LCD LORAN-C signal data 

MLA Glonass almanac data 
MSK MSK receiver interface 

MSS MSK receiver signal status 

MTW Water temperature 

MWD Wind direction and speed 
MWV Wind speed and angle 

OSD Own ship data 

PGN NMEA 2000 PGN data 

RMA Recommended minimum specific LORAN-C data 
RMB Recommended minimum navigation information 

RMC Recommended minimum specific GNSS data 

ROT Rate of turn 

RPM Revolutions 
RSA Rudder sensor angle 

RSD Radar system data 

RTE Routes 

SFI Scanning frequency information 
STN Multiple data ID 

TLB Target label 

TLL Target latitude and longitude 

TTM Tracked target message 
TXT Text transmission 

VBW Dual ground/water speed 

VDR Set and drift 

VHW Water speed and heading 
VLW Distance travelled through the water 
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VPW Speed, measured parallel to wind 
VTG Course over ground and ground speed 

WCV Waypoint closure velocity 

WNC Distance, waypoint to waypoint 

WPL Waypoint location 
XDR Transducer measurements 

XTE Cross-track error, measured 

XTR Cross-track error, dead reckoning 

ZDA Time and date 
ZDL Time and distance to variable point 

ZFO UTC and time from origin waypoint 

ZTG UTC and time to destination waypoint 
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Supported NMEA 2000 PGN list 

PGN 
Decimal 

PGN            
Hex 

Description TX RX 

59392 E800 ISO Acknowledge • • 
59904 EA00 ISO Request • • 
60160 EB00 ISO Transport Protocol, Data Transfer • • 
60416 EC00 ISO Transport Protocol, Connection Management • • 
60928 EE00 ISO Address Claim • • 
65240 FED8 ISO Commanded Address • • 
65286 FF06 Fluid Flow Rate (Maretron Proprietary)  • 
65330 FF32 Mast Angle (ShipModul Proprietary) •  

126208 1ED00 Request/Command/Acknowledge group function • • 
126464 1EE00 Received/Transmitted PGNs group function •  
126720 1EF00 SeaTalk Data (Raymarine Proprietary) • • 
126992 1F010 System Time • • 
126993 1F011 Heartbeat •  
126996 1F014 Product Information • • 
126998 1F016 Configuration Information • 

 

127237 1F105 Heading/Track Control • • 
127245 1F10D Rudder • • 
127250 1F112 Vessel Heading • • 
127251 1F113 Rate of Turn • • 
127252 1F114 Heave  • 
127257 1F119 Attitude • • 
127258 1F11A Magnetic variation • • 
127488 1F200 Engine Parameters, Rapid Update 

 
• 

127489 1F201 Engine Parameters, Dynamic  • 
127505 1F211 Fluid Level  • 
127506 1F212 DC – Detailed Status  • 
127508 1F214 Battery Status  • 
128259 1F503 Speed, Water referenced • • 
128267 1F50B Water Depth • • 
128275 1F513 Distance Log • • 
129025 1F801 Position, Rapid Update • • 
129026 1F802 COG & SOG, Rapid Update • • 
129029 1F805 GNSS Position Data • • 
129033 1F809 Local Time Offset (V1.300 Time and Date) 

 
• 

129038 1F80E AIS Class A Position Report (msg. 1,2,3) • • 
129039 1F80F AIS Class B Position Report (msg. 18) • • 
129040 1F810 AIS Class B Extended Position  Report (msg. 19) • • 
129041 1F811 AIS Aids to Navigation (AtoN) report (msg. 21) • • 
129283 1F903 Cross Track Error • • 
129284 1F904 Navigation Data • • 
129285 1F905 Navigation - Route/Waypoint information • • 
129291 1F908 Set & Drift, Rapid Update • • 
129539 1FA03 GNSS DOP's • • 
129540 1FA04 GNSS Sats in view • • 
129793 1FB01 AIS Base Station (msg. 4) • • 
129794 1FB02 AIS Class A Static and Voyage Related Data (msg. 5) • • 
129798 1FB06 AIS SAR Aircraft Position Report (msg. 9) • • 
129802 1FB0A AIS Safety Related Broadcast Message (msg. 14) • • 
129809 1FB11 AIS Class B “CS” Static Data Report, Part A (msg. 24a) • • 
129810 1FB12 AIS Class B “CS” Static Data Report, Part B (msg. 24b) • • 
130074 1FC1A WP List - WP Name & Position •  

130306 1FD02 Wind Data • • 
130310 1FD06 Environment (deprecated) 1 • 
130311 1FD07 Environment (deprecated) 1 • 
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PGN 
Decimal 

PGN            
Hex 

Description TX RX 

130312 1FD08 Temperature (deprecated) 1 • 
130313 1FD09 Humidity • • 
130314 1FD0A Actual Pressure • • 
130316 1FD0C Temperature, extended range • • 
130578 1FE12 Vessel Speed Components • • 
131071 1FFFF Simrad TV80 Data (ShipModul Proprietary) • • 

Notes: 

1: These PGN’s are transmitted instead of 130313, 130314 and 130316 if the Device Type of an NMEA 0183 input is 
set to Weather Instrument (<V2). 

 

Conversions from NMEA 2000 to NMEA 0183 

PGN Description Type Sentence Freq. Note 

65286 Fluid Flow Rate (Maretron Proprietary) I YXXDR 2 
 

126992 System Time D ZDA 1 1 

127237 Heading/Track Control D HDG, HDT or THS 10 
 

127245 Rudder D RSA 2 
 

127250 Vessel Heading D HDG, HDT or THS 10 
 

127251 Rate of Turn D ROT 10 
 

127252 Heave I YXXDR or PFEC,GPhve 10 
 

127257 Attitude I YXXDR or PFEC,GPatt 1 
 

127258 Magnetic variation D HDG, RMC - 2 

127488 Engine Parameters, Rapid Update I ERRPM, ERXDR 10 
 

127489 Engine Parameters, Dynamic I ERXDR 2 
 

127497 Trip Fuel Consumption, Engine I ERXDR 1  
127505 Fluid Level I YXXDR 0.4 

 

127506 DC – Detailed Status D ERXDR 1  
127508 Battery Status D ERXDR 1 

 

128259 Speed, Water referenced D VBW, VHW 10 
 

128267 Water Depth D DBT or DPT 1 
 

128275 Distance Log D VLW 1 
 

129025 Position, Rapid Update D GGA, GLL, RMC 1 3 
129026 COG & SOG, Rapid Update D RMC, VTG 1 3 
129029 GNSS Position Data S GGA, GLL, RMC 1 3 
    D ZDA 1 

 

129033 Local Time Offset (V1.300 Time and Date) D ZDA 1 1 

129038 AIS Class A Position Report (msg. 1,2,3) I VDM, VDO - 
 

129039 AIS Class B Position Report (msg. 18) I VDM, VDO - 
 

129040 AIS Class B Extended Position Report (msg. 19) I VDM, VDO - 
 

129041 AIS Aids to Navigation (AtoN) report (msg. 21) I VDM, VDO - 
 

129283 Cross Track Error D APB, RMB, XTE 1 
 

129284 Navigation Data D APB, BWC/BWR, RMB, 
ZTG 

1 4 

129285 Navigation - Route/WP Information D APB, BWC/BWR, RMB, 
ZTG 

1 4 

129291 Set & Drift, Rapid Update D VDR 1 
 

129539 GNSS DOP's D GGA, GSA 1 
 

129540 GNSS Sats in view I GSA, GSV - 
 

129793 AIS Base Station (msg. 4) I VDM, VDO - 
 

129794 AIS Class A Static/Voyage Data (msg. 5) I VDM, VDO - 
 

129798 AIS SAR Aircraft Position Report (msg. 9) I VDM, VDO - 
 

129802 AIS Safety Related Broadcast Message (msg. 14) I VDM, VDO - 
 

129809 AIS Class B Static Data report: Name (msg. 24a) I VDM, VDO - 
 

129810 AIS Class B Static Data report: Static Data (msg. 24b) I VDM, VDO - 
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PGN Description Type Sentence Freq. Note 
130306 Wind Data D MWD, [MDA] 1 5 
    

 
MWV 5 

 

130310 Environment (deprecated) D MTW, XDR, [MDA] 1 5 
130311 Environment (deprecated) D MTW, XDR, [MDA] 1 5 

130312 Temperature (deprecated) D MTW, XDR, [MDA] 1 5 
130313 Humidity D XDR, [MDA] 1 5 
130314 Actual Pressure D XDR, [MDA] 1 5 
130316 Temperature, extended range D MTW, XDR, [MDA] 1 5 
130578 Vessel Speed Components D VBW, VHW 10 

 

131071 Simrad TV80 Data (ShipModul Proprietary) I PSIMTV80 - 
 

Type: 

D: Conversion through database, no direct link between reception of PGN and transmission of sentence. 

I: Immediate conversion: PGN is converted to sentence and transmitted immediately. The indicated frequency of 
this sentence is equal to the frequency of the received PGN and is the default value as specified by NMEA 2000. 
The actual frequency depends on the implementation of the transmitting device. 

S: Conversion through database, transmission of sentence is synchronized with reception of PGN to minimize 
latency. 

Notes: 

1: ZDA must be specifically enabled on the Options tab. 

2: The magnetic variation is stored only; it does not trigger transmission of HDG or RMC sentences. 

3: The frequency of these sentences can be set to 10 Hz (except ZDA). 

4: Either BWC or BWR is transmitted, depending on field 6 (Calculation Type: Great Circle or Rhumb Line) of PGN 
129284. If the calculation type is unspecified, great circle (BWC) will be assumed. 

5: MDA must be specifically enabled. High-resolution barometric pressure from PGN 130314 has precedence over 
low resolution barometric pressure of PGNs 130310 and 130311. 
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Conversions from NMEA 2000 to NMEA 0183 XDR sentences 
Several NMEA 2000 PGNs are converted to NMEA 0183 XDR sentences using specific Transducer Types, 

Units and Transducer ID’s, in accordance with NMEA 0183 V4.11 wherever possible. Whenever a PGN 
supports an Instance field and this Instance field contains a valid number, this number is appended to 

the Transducer ID. 

A Transducer ID for the first/port engine would thus be “Engine#0”, and the second/starboard engine 

would be “Engine#1” 

Engine data 
Engine data is converted to $ERXDR sentences using Transducer Types, Units and ID’s below: 

PGN Parameter Type Unit ID Note 

127488 Boost pressure P B (bar) EngineBoost  
127488 Engine tilt A P (%) EngineTilt  

127489 Engine oil pressure P B (bar) EngineOil  

127489 Engine oil temperature C C (°C) EngineOil  

127489 Engine temperature C C (°C) Engine  

127489 Alternator voltage U V (Volt) Alternator  

127489 Fuel rate R l (liters/second) Fuel  

127489 Engine hours G - EngineHrs  

127489 Engine coolant pressure P B (bar) EngineCool  

127489 Fuel pressure P B (bar) Fuel  

127489 Engine status G - EngineSts  

127489 Percent engine load G P (%) EngineLoad  

127489 Percent engine torque G P (%) EngineTorq  

127497 Trip fuel used V M (m3) FuelTrip  

127497 Average fuel rate R l (liters/second) FuelAvg  

127497 Economy fuel rate R l (liters/second) FuelEcon  

127497 Instantaneous fuel economy R l (liters/second) InstEcon  

127506 State of Charge G P (%) SoC  

127506 State of Health G P (%) SoH  

127506 Time Remaining G M (minutes) Trem  

127506 Ripple Voltage U V (Volt) Ripple  

127506 Amp Hours    1 

127508 Voltage U V (Volt) * 2 

127508 Current I A (Ampere) * 2 

127508 Case temperature C C (°C) * 2 

Notes: 

1: The cumulative amp hours drawn since a battery was full 

2: The Transducer ID can be one of the following: 
Battery 
Alternator 
Convertor 
Solar 
WindGen 
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Generic sensor data 
Generic sensor data is converted to $YXXDR sentences using Transducer Types, Units and ID’s below: 

PGN Parameter Type Unit ID 

65286 Fluid flow rate 
 

R l (liters/second) Fuel 
    FreshWater 

    WasteWater 

    LiveWater 

    Oil 

    BlackWater 

    Gasoline 

127505 
 

Fluid Level 
 

E P (%) Fuel 

 
 

   FreshWater 

    WasteWater 

    LiveWater 

    Oil 

    BlackWater 

    Gasoline 

Meteorological data 
Meteorological data is converted to $WIXDR sentences using Transducer Types, Units and ID’s below: 

PGN Parameter Type Unit ID 

130310 Outside temperature C C (°C) Air 
130310 Atmospheric pressure P B 

(bar) 
Baro 

130311 Outside temperature C C (°C) Air 

130311 Outside humidity H P (%) Air 

130311 Atmospheric pressure P B 
(bar) 

Baro 

130312 Outside temperature C C (°C) Air 

130313 Outside humidity H P (%) Air 

130314 
 

Atmospheric pressure P B 
(bar) 

Baro 

130316 
 

Outside temperature C C (°C) Air 
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Conversions from NMEA 0183 to NMEA 2000 

Sentence Description Type PGN Freq. Note 

APB Heading/Track controller (to autopilot) D 129283 1 
 

  
  

129284 1 
 

    
 

129285 1 
 

DBT Depth below transducer D 128267 1 
 

DPT Depth D 128267 1 
 

GGA GPS - latitude/longitude, fix data D 126992 1 
 

  
  

129025 10 
 

  
  

129029 1 
 

    
 

129539 1 
 

GLL GPS - latitude/longitude D 126992 1 
 

  
  

129025 10 
 

    
 

129029 1 
 

GSA GNSS DOP & active satellites D 129539 1 
 

    
 

129540 1 
 

GSV GNSS satellites in view D 129540 1 
 

HDG Heading ,Magnetic, deviation & variation D 127250 10 
 

    
 

127258 1 
 

HDM Heading, Magnetic D 127250 10 
 

HDT Heading, True D 127250 10 
 

MDA Meteorological data D 130313 0.5 6 
  

  
130314 0.5 

 

    
 

130316 0.5 
 

MTW Water temperature D 130316 0.5 6 

MWD Wind direction & speed D 130306 10 
 

MWV Wind angle & speed D 130306 10 1 
PSIMTV80 Simrad TV80 Data (ShipModul Proprietary) I 131071 

 
4 

RMB Navigation Data (to autopilot) D 129283 1 
 

  
  

129284 1 2 
    

 
129285 1 

 

RMC GPS - latitude/longitude, SOG, COG, variation D 126992 1 
 

  
  

127250 - 3 
  

  
127258 1 

 

  
  

129025 10 
 

  
  

129026 4 
 

    S 129029 1 
 

ROT Rate of turn D 127251 10 
 

RSA Rudder sensor angle D 127245 10 
 

THS Heading, True D 127250 10 
 

VBW Dual ground/water speed D 128259 1 
 

    
 

130578 4 
 

VDM/VDO AIS I 129038 - 
 

  
  

129039 - 
 

  
  

129040 - 
 

  
  

192041 - 
 

  
  

129793 - 
 

  
  

129794 - 
 

  
  

129798 - 
 

  
  

129802 - 
 

  
  

129809 - 
 

    
 

129810 - 
 

VDR Set & drift D 129291 1 
 

VHW Water speed & heading D 127250 10 
 

  
  

128259 1 
 

    
 

130578 4 
 

VLW Dual ground/water distance D 128275 1 
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Sentence Description Type PGN Freq. Note 

VTG Course over ground & ground speed D 129026 4 
 

VWR Apparent wind angle & speed D 130306 10 
 

VWT Theoretical/true wind angle & speed D 130306 10 
 

WPL Waypoint location I 130074 - 
 

XDR Mast Angle D 65330 2 4 
XDR Air temperature, humidity and barometric pressure D 130313 0.5 5,6 
   130314 0.5  
   130316 0.5  
      
XTE Cross track error (to autopilot) D 129283 1 

 

ZDA Time & date D 126992 1 7 

ZTG UTC & time to destination waypoint D 129284 1 
 

Type: 

D: Conversion through database, no direct link between reception of sentence and 
transmission of PGN. 

I: Immediate conversion: Sentence is converted to PGN and transmitted immediately. 

S: Conversion through database, transmission of PGN is synchronized with reception of 
sentence to minimize latency. 

Notes: 

1: When true wind is converted, the MiniPlex-3 will transmit this PGN twice:  with Wind 
Reference 3 (calculated referenced to ground) and Wind Reference 4 (calculated 
referenced to water) to ensure compatibility with all receivers. 

2: Field 6 (Calculation Type) of PGN 129284 will be set to Great Circle. 

3: The magnetic variation is extracted from the RMC sentence, but this does not trigger 
transmission of PGN 127250. This PGN will only be transmitted on reception of a 
heading sentence. The stored magnetic variation will then be placed in PGN 127250. 

4: This is a proprietary PGN. 

5: The Talker ID must be "WI". Decoded parameter groups are respectively: 
“C,x.x,C,TEMP”, “P,x.x,B,PRESS” and “H,x.x,P,RH”. 
Parameter group “C,x.x,C,AirTemp” is decoded with any Talker ID. 

6: If the Device Type of an NMEA 0183 input is set to Weather Instrument (<V2), PGN’s 
130310, 130311 and 130312 are transmitted instead of 130313, 130314 and 130316. 

7: Decoded parameter groups are: “A,x.x,D,PTCH” and “A,x.x,D,ROLL”. 

8: PGN 126992 must be specifically enabled on the Options tab. 
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Converted SeaTalk Datagrams 

Datagram Description TX RX Note 

00 Depth below transducer • •  
01 Equipment ID • • 1 

10 Wind angle • •  
11 Wind speed • •  
20 Speed through water, 1/10 kn • • 2 
21 Trip mileage • • 3 
22 Total mileage • • 3 
23 Water temperature, C + F • • 4 

25 Total and Trip mileage • • 3 

26 Speed through water, 1/100 kn • • 2 
27 Water temperature 1/10 C • • 4 

30 Set lamp intensity • • 1 
50 Latitude • • 5 
51 Longitude • • 5 
52 Speed over ground • •  

53 Course over ground • •  

54 Time • •  
56 Date • •  
57 GPS Satellites & HDOP  •  

58 Latitude and longitude • • 5 
80 Set lamp intensity • • 1 
81 Course computer message • • 1 
82 Short waypoint name • • 6 

83 Course computer message • • 1 
84 Autopilot heading and rudder position  •  
85 Navigation data • •  
86 Keystroke (incl. S100 remote control) • • 1 
87 Set response level • • 1 
88 Autopilot parameters • • 1 
89 Heading • •  

90 Equipment ID • • 1 
91 Set rudder gain • • 1 
92 Set autopilot parameter • • 1 

93 Enter autopilot setup • • 1 
95 Autopilot setup output • • 1 
99 Magnetic variation • •  
9A Version string • • 1 

9C Compass heading and rudder position  •  

A1 Long waypoint name • • 6 
A2 Arrival status • •  

A3 Rudder angle • •  
A4 Device query broadcast/device ID • • 1 
A5 GPS info and status • •  

Notes: 

1: These datagrams are converted from/to Raymarine proprietary PGN 126720 if 
In1 is set to SeaTalk-STNG mode. 

2: Datagram 20 is ignored if datagram 26 is received. 

3: Datagrams 21 and 22 are ignored if datagram 25 is received. 

4: Datagram 23 is ignored if datagram 27 is received. 

5: Datagrams 50 and 51 are ignored if datagram 58 is received. 

6: Datagram 82 is ignored if datagram A1 is received. 
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When option Raw SeaTalk is enabled, unlisted datagrams are converted into a proprietary NMEA 

sentence with the following format: 

$PSMDST,R,aa,bb,cc…*hh<CR><LF> 

aa,bb,cc… represent the hexadecimal value of the bytes from the received SeaTalk datagram. 

Firmware Update Error messages 
During a firmware update, the following warnings or error messages may be displayed: 

The firmware update failed 
This message appears when the overall update process failed without any other error message. It is 

shown when the updated multiplexer firmware does not report a version message after start-up. 

Not a valid firmware file 

The file you are trying to open is not a valid firmware file. A firmware file not only ends with an “.mpx” 
extension, it also contains a distinct signature that must be present. This prevents you from 

accidentally loading the wrong file into the multiplexer. 

Unsupported firmware file version 

The firmware file version is not supported by MPXConfig3 

Firmware file is corrupt 

The firmware file is damaged, possible due to an error during download from our website. 

The version of the firmware file is lower than the version of the multiplexer. Do you really 

want to proceed? 
You are trying to update the firmware in the multiplexer with an older version. This is just a warning 

and very well possible to do. 

Bootloader initialisation failed 

When MPXConfig3 starts the update process, a small program called the Bootloader must be started in 
the multiplexer. This message tells you that the bootloader could not be started. This can happen 

when you try to update the multiplexer while navigation instruments are connected and sending lots 

of NMEA data to the multiplexer. This can interfere with starting the update process. Disconnect or 

power down the instruments to prevent this problem. 

Firmware file does not match with the multiplexer type 

Most firmware files will be compatible with all types of multiplexers. It is however possible that special 

firmware is made available which only runs on a specific type of multiplexer. If this message appears, 

you apparently are trying to update using a firmware file that is not suitable for your type of 

multiplexer. 

Bootloader: Erase command timeout 

An error occurred when the bootloader tried to erase the old firmware. 

Bootloader: Encryption command timeout 

The bootloader did not respond to the Encryption command sent by MPXConfig3.  

Bootloader: Programming timeout 

There was an error during programming a section of the firmware image. 

Bootloader: CRC command timeout 

The bootloader failed to calculate the checksum of the newly loaded firmware image. 

Bootloader: CRC error 

The calculated checksum of the newly loader firmware image does not match the checksum if the 

image file. Apparently, there was a communication error between MPXConfig3 and the multiplexer. 

You can try to update again. 

Invalid response from bootloader 

The bootloader returned an unknown response to a command from MPXConfig3. 
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Technical Specifications 

NMEA 0183 Compatibility 
All inputs and host interfaces of all MiniPlex-3 models follow the NMEA 0183 standard: 

• Received sentences must begin with a ‘$’ or a ‘!’ character and end on CR and LF characters in that 

order. 

• A checksum is not required but verified if present. 

• The sentence length may not exceed 82 characters. NMEA input 4 however accepts sentences up to 

145 characters to accommodate non-compliant sources. 

A checksum is added to all sentences generated or forwarded by the MiniPlex-3. Sentences transmitted 

by the MiniPlex-3 will not exceed 82 characters. 

This implies that sentences received without a checksum and longer than 78 characters will not be 

extended with a checksum, as this would violate the 82-character limit. 

MiniPlex-3USB 
Supply voltage: 8 – 35 VDC, protected against reversed polarity. 

Current consumption: 50 mA (100 mA max. with fully loaded talker ports). 

Host interface: USB, galvanically isolated. 

Inputs: 4 x NMEA 0183/RS-422, galvanically isolated. Input 1 can be set to 

SeaTalk mode. NMEA 0183 sentences up to 145 characters can be 

received. 

Input resistance: >1.4 kOhm 

Input current: 0.5mA @ 2V 

3.0mA @ 5V 

7.1mA @ 10V 

Outputs: 2 x NMEA 0183/RS-422, galvanically isolated. 

Max output current: 20mA @ >2V 

Routing table size: 50 sentence types 

Priority table size: 50 sentence types 

Speed NMEA inputs: 4800 - 115200 Baud 

Speed NMEA outputs: 4800 - 115200 Baud 

Indicators: Overflow and Data 

Dimensions: 138 x 72 x 33 mm 

Housing: Flame retardant ABS. 

MiniPlex-3USB-N2K 
NMEA 2000 Port: LEN: 1 

Speed: 250kbps 

NMEA 2000 Manufacturer Code: 595 

NMEA 2000 Product Code: 12738 

Connector: M12 male Micro-C 
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MiniPlex-3E 
Supply voltage: 8 – 35 VDC, protected against reversed polarity. 

Current consumption: 100 mA (150 mA max. with fully loaded talker ports) 

Host interface: 10BASE-T/100BASE-TX Ethernet 

Supported protocols: TCP or UDP, port 10110 for NMEA communication 

TCP, port 10110 for firmware updates 

TCP and UDP, port 30718 for network configuration 

ARP, ICMP and DCHP for network management 

Inputs: 4 x NMEA 0183/RS-422, galvanically isolated. Input 1 can be set to 

SeaTalk mode. NMEA 0183 sentences up to 145 characters can be 

received. 

Input resistance: >1.4 kOhm 

Input current: 0.5mA @ 2V 

3.0mA @ 5V 

7.1mA @ 10V 

Outputs: 2 x NMEA 0183/RS-422, galvanically isolated. 

Max output current: 20mA @ >2V 

Routing table size: 50 sentence types 

Priority table size: 50 sentence types 

Speed NMEA inputs: 4800 - 115200 Baud 

Speed NMEA outputs: 4800 - 115200 Baud 

Indicators: Overflow and Data 

Dimensions: 138 x 72 x 33 mm 

Housing: Flame retardant ABS. 

MiniPlex-3E-N2K 
NMEA 2000 Port: LEN: 1 

Speed: 250kbps 

NMEA 2000 Manufacturer Code: 595 

NMEA 2000 Product Code: 26884 

Connector: M12 male Micro-C 
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MiniPlex-3Wi 
Supply voltage: 8 – 35 VDC, protected against reversed polarity. 

Current consumption: 70 mA (120 mA max. with fully loaded talker ports) 

Host interface: USB, galvanically isolated 

WiFi, 802.11 b/g/n at 2.4 GHz 

WiFi interface: Frequency band: 2.412 – 2.484 GHz 

Output power: 16.5 dBm 

Supported protocols: TCP and UDP, port 10110 for NMEA communication 

ARP, ICMP and DCHP for network management 

Inputs: 4 x NMEA 0183/RS-422, galvanically isolated. Input 1 can be set to 

SeaTalk mode. NMEA 0183 sentences up to 145 characters can be 

received. 

Input resistance: >1.4 kOhm 

Input current: 0.5mA @ 2V 

3.0mA @ 5V 

7.1mA @ 10V 

Outputs: 2 x NMEA 0183/RS-422, galvanically isolated. 

Max output current: 20mA @ >2V 

Routing table size: 50 sentence types 

Priority table size: 50 sentence types 

Speed NMEA inputs: 4800 - 115200 Baud 

Speed NMEA outputs: 4800 - 115200 Baud 

Indicators: Overflow and Data 

Dimensions: 138 x 72 x 33 mm 

Housing: Flame retardant ABS. 

MiniPlex-3Wi-N2K 
NMEA 2000 Port: LEN: 1 

Speed: 250kbps 

NMEA 2000 Manufacturer Code: 595 

NMEA 2000 Product Code: 24180 

Connector: M12 male Micro-C 
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Contact Information 
ShipModul B.V. 

Zwedenlaan 3 
9403 DD  Assen 

The Netherlands 

Tel: +31 592 375700 

www: www.shipmodul.com 

e-mail: support@shipmodul.com 
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